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Introduction 1

1.1

Introduction

About HIPAA Claim Payment Master

Electronic Data Interchange (EDI) plays an ever increasing role in the exchange of
information between healthcare providers and healthcare payers and/or clearing houses.

Most people don't know EDI when asked about it, but have an intuitive understanding
when told that EDI makes ATM transactions possible. When you swipe your bank card at
any ATM in the world, an EDI transaction is created in the ATM machine and sent through
a network to your bank. Your bank in turn takes the ATM transaction and sends back a
response EDI transaction releasing the funds to you. The banking system in the world has
been working on EDI for a much longer time then the healthcare industry but we will see
in our lifetime that healthcare transactions will be similarly smooth, fast and reliable.

HIPAAsuite has software applications for all 12 HIPAA mandated transactions. The HIPAA
Claim Payment Master is designed to display, print and save the data of EDI X12 files
that are likely to come from a payer back to the provider such as the 835 Electronic
Remittance report. EDI is a very non-intuitive format and designed around computer
efficiency and not human readability. Below is an example of an EDI file; you can
recognize only few words in this garble. The HIPAA Claim Payment Master takes the
cryptic EDI files, parses out the information, translates the codes back to English and
allows one to print and display the information, so that it can be viewed, understood,
interpreted and entered into an accounting system. The software can also export the
payment information contained in 835 Remittance Advice files into any ODBC aware
database such as Microsoft SQL Server, Microsoft Access, MySQL, Oracle and so on. This
way the information is searchable and it will be easy to write programs to import the
data into existing systems.

EDI is increasingly adopted in the health care industry and mandated by the HIPAA act of
1996. EDI is ideal to exchange information between computers but it is inherently hard to
read for humans. Many complex properties are represented as two-letter abbreviations.
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ISA™DO™ 00" *ZZ* 1234567897200 6104427020518"1601*U"00401%229800002 0T~
GS*HP9998887766~987654"200210261135~229500002=004010X091™

ST*83572293800002~
BPR"C*175.00*C*CHK 20020518™
TRN*"1*16588%1521685100™

DTM=405-20020509™

M1*PR*Great Benefit Plan™

N3*100 MAIN STREET™

MNA*KAMNSAS CITY"MO*84108™

N1'PE"DR MARCUS J WELBY"FI"097654322™

M3I"55 HIGH STREET™

MNA*SEATTLE*WA™38123™

L™
CLP*385019*1*305.00*175,00%15,00"12%229800001*11™
NM1*QC™1* DOE*JOHN"P™MI*11122333301™
NM1=82=2*WELBY*JOHN™FI*387121234™
DTM=050"20020504™

SVC*HC:99244*75.00"60.00™

DTM=472-20020501™

The beginning of an 835 EDI file

Meﬂ’ﬂigﬂfm e e A e | e W T i, e T

The above is an example of an 835 file. One can easily see bits of information but a lot

of it is translated into codes that are not intelligible. Most often EDI files have no
carriage returns so that the information looks even more confusing.
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Introduction

Explanation of Payment

PHE Great Benefit Plan A5 bR MARCUS JWELBY
100 MAIN STREET 55 HIGH STREET
KANSAS CITY, MO 64108 SEATTLE, WA 98123
Pay Method Check Hank ID
Arcount # ACcount#
ChE I55JEFT Daate 0182002 Total Ami
Fayer D ChetkEFT Mo 16588

————eeeeee————— |20 1

| Fatient Name: JOHN P DOE Member ID Number 11122333301
| Frovider Mame:  JOHN WELBEY Fedaral ID QETI21234
Claim ldentfiar 985019 Status. Processed as Primary DRG Code
Total Charge Amit Facility Office Control # 229800001
Fayrmenl Al Fraguency DRG Weight
Patiant Resp Amt Filling Provider Organization Discharge Fraction
| Recaivad 04.05.2002 ]
Claim Line Adjudication
94 | Froc.. HC 99244 Charge | Paid Faid Unils Bundl
\djustment Reason Group Adjustment Reason Amournt Gty
Patient Responsibility 3 - Co-pinanent Amournt
Sernvice Date: 01.05.2002 |
2 | Froc. HC 81000 Charge | Paid: | Paid Units | Bundl,
Senica Dafe: 01.05.2002 |
3 | Proc. HC 87088 Charge | Paid | Paid Units | Bundl
Adjustrment Reason Group | Adjustment Reason Amournt ity
Payor Infiated Reductions | BS - Payment adjusted because coverageprogram guidelines were not
meet or were exceeded.
Senice Date 01.05.2002 |

The display of the Remittance advice for a single claim

Here you can see that the information resembles the paper EOB's or EOP's that were

traditionally sent by mail. The HIPAA Claim Payment Master translates the code sets and
orders the information so that you can see exactly what payments were made and which

deductions taken.

Summary information is displayed upfront, and each claim listed with the adjudication

information and service line information structured with all the details found in the EDI

file. Read more in Identifying the Informationl 12\,
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The HIPAAsuite Claim Payment Master

2.1

Getting Started
Starting the Application

Once the HIPAA Claim Payment Master is installed, you can launch it from the "Start”
menu:

Start » Programs (All Programs) » HIPAASuite » HIPAA Claim Payment Master.

HIFAASLte

B HIFAA Claim Payment Master

= Marusal For HIPAA Claim Payment iMaster
HIPAA, Authorizer
HIPAA Claim Master
HIP&& Comm Cenber
HIPAS, Elgbility Respondar
HIFAR, Prsmium Payment Master
HIFARACLaimStabusR esponder
HIFAAsUte

Payment |

Q_'Slurtp

The HIPAA Claim Payment Master is launched from the "Start” menu

The following screen will appear:
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Getting Started 5

s HIPAA Claim Payment Master - B4bit

Run

B with
compliance check

Checking For updates .:

The HIPAA Claim Payment Master main window

Tip: If the left pane is not displayed, then select View k Info Bar to show it.

= HIPAA Claim Payment Master - B4bit

File || View _DataExport CodeSets Image Setup  EDI Exchange  Help
e --"'\.‘ =

B EOTEditor = “ @ 0

Log

i

Once the main program window is opened, the normal operation now would be to open
an EDI file. See:

e Processing a Payment Advice Filel 5

e Opening a Folder Containing EDI Files[ ¢

2.2 Processing a Payment Advice File

Follow the instructions below to open a single EDI file and display its details on screen in
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easy-to-read table format.

1. Go to File » Open in the main menu.

B HiPAA Claim Payment Ma
File |} View  Daba Export
Open Sampls Fie

Open
Cpen Directory

Select Prinker

Exit

The "Open” menu

Alternatively, click on the "Open Document” icon shortcut located on the program
toolbar.

"..', HIPAA Clainm Payment Master - bahit

File Wiew DataExport CodeSets Image Setup EDIExchangs  Help

=) > &9 O

The "Open Document” button

2. Browse through the folders and select a file with . edi extension. Click "Open.”

Note: Only claim files in "ANSI 835" format can be opened via the Claim Payment Master. The program
will display an error message if you select a file in a different format.

Reference: ANSI 835 is the American National Standards Institutes Health Care Claims Payment and
Remittances Advice Format.
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Getting Started 7

n Choose EDI file B
I'\._-"ll{--"i = HIPAA Claien Payment Master = Samples - E | Search Samples ﬁﬂ]
Organize =  New folder : o~ [ ,ﬂ

r Eavoritas Mame = | Diate modified | Type
[ Deskiop B35I1.ad 2/5/2012 1:06 PM EDI File
4§ Downloads

2/5f2012 1:05 PM EDI File

= Recent Places

il Libraries
&| Documants
o Music
= Pictures

E Wideos

M Cornputer
& Local Disk (C2)
» DATARARTI (D)

€8 Metwork

1| | i3
File name: |$35]2.ed| El ['ﬂd' files (%) 3

Open Cancel |

The "Choose EDI File" window

3. Make sure the program tool bar is displayed in the left area. To display the left
program bar with options, select View » Info Bar.

4. Select one of the following modes in the "Output Mode" box. The Output mode defines
the destination where the result file will be sent to.

e Printer — Select this option to print the opened EDI file.

e Screen — This is a default mode. select this option to display the EDI file on screen
in a preview window.

¢ Image File — Select this mode to create TIFF or PDF file. You should have the

settings configured to print the file to image. Read more in Creating Image Files
from EDI s8l.

— Dutput Mode
" Prinker
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The HIPAAsuite Claim Payment Master

The "Output Mode" options

5. Click on the "Run" button.

A HiPAA Claim Payment Mast

Wiew  DataExport

File
E @ Ve

~— Dutput Mode
" Printer

{* Screen

™ Image File

[ Data Import

Counter

83512 edi

T —
Ous [ ]

( Run !‘

The "Run" buttons

6. When you click on the "Run” button, the file will be parsed and the information
displayed. The HIPAA Claim Payment Master recognizes the type of the EDI transaction
and displays Payment Advice and Claim Status information separately. The following
pertains to the X12 835 Electronic Payment Advice.

As in our example the output mode is "Screen,” the claim is displayed in a separate
window.
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Getting Started 9

2.3

: Print  Close = 11 == | Help
Explanation of Payment
PAET Great Benst Plan PEEE b MARCUIS ) WELEY
100 MAIN STREET 55 HIGH STREET
HKANSAS CITY, MO 64108 SEATTLE, WA 98123
Pay Wethod Chick Bank D
Accound # Account #
ChklssEFT Dake AR Totad Amt $1r5.00
Fayar il ChetkEFT No 16508
Claim 1
I Falent Mame redacted redacted Member ID Numiber redacted
[ nsured Hame:  redacted redacted Mermber ID Hurmiber redacied
l Erovider Mame redacted Faderal ID redacted
Claim |dendsiar MEAGEISE26 Salus: Processaed as Secondany DR Codie
Todal Charge Amt: $19500 Fatility Control # (vl g |
Payment At oo Fregquency DRG Waight
Faient Recp Amt 8500 Filling Poiid of Sendcs Digchargs Frathon
[ GraigPality Humbér DR 2104 |
Claim Line Adjudication
1 [Fioc AD DO14D [ Charge $67.00 [ Fadd $0.00 [ Faid Linits [ Bundl
Adustnent Reason Group | Adjusiment Reason Amount Qty
Patient Fesponsibility 2F . Paymen adjusied becausa this cane may e covened by another 4880
paEyar per coordination of heneits.
Contractizal Obligations A2 . Charges eocesed our N schidule or maimum allowable amount. 1820
Serdce Dale [Tt
2 |Fioc AD DOZ20 | Chamge §26,00 | Fad §0.00 | Fasd Uinits: |E|-.u-:||
Adpistrien Feason Gnoup Adjustiment Reason Ammpund [*]]
Pratieend Responsibilihy 22 - Paymend adusted becauss this care miny be covmred by another 2120
payet per coordination of benefits.
Contractsal Obligations 47 - Charges exceed owr fee schedule or madmum allowable amount. 480
Sendce Date [Tt T
2 | Froc AD DOZ2D | Chamge $26.00 | Fad $0uDo | Faid Uinits |Hurjl
At n! e st oh Broup Adjustmenl Reason Adnidiind [+17]
Pratieend Responsibilihg 22 - Paymend adjusted because this care may be covened by another 2120
payer por coordination of benefits.
Contractsal Obligations 42 - Charges eocetd owr fiee schidule o maximum allowable amount. 480
Sarnce Date 1530 T 1T
3 | Froc AD DOZI0 | Chamge: $22/00 | Fad $0.00 | Fasd Linits: ]F.Iun:ll
Adustnent Reason Group | Adjusiment Reason Amount Qty
Patient Hesponsbility 22 . Paymen adjusied becausa this care may e covenad by another §15.80
paEyar per coordinaton of henefits.
Contractieal Obligations 42 . Charges eoceed our fee schidule or masimuam allovable amount. 6.0
Berdce Dale [ETen T |

The display of an 835 Payment Advice

Opening a Folder Containing EDI Files

The "Open Directory” function works only when the output mode is not "Screen” but "Data
Export” or "Image File".

Follow the instructions below to open a batch of EDI files located in one folder.
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10 The HIPAAsuite Claim Payment Master

1. Make sure the "Printer” or "Image File" mode is selected in the "Output Mode" box. The
Output mode defines the destination where the result file will be sent to.

Note: You cannot display a batch of EDI files on screen in a preview window, it is possible only for one
file. See Processing a Payment Advice File[ 5V

n HIPAA Claim Payment Mast
File  Wiew DataExport C

E VT

~ Dutput Mode
@P‘rﬂm

" Screen
() image Fie

The "Output Mode" options

Note: If you select the "Image File" format for the first time, you need to define the image options.
See Doing Image Setup[4d.

2. Go to File » Open Directory in the main menu.

B HiPAA Claim Payment Ma

Wiew DataExport

Cpen Sample File
==
[ openDirectory
i Select Prinbes
Exit

The "Open Directory” menu

3. Browse for the folder containing EDI files. Click on that folder and then click "OK."

Note: Only claim files in "ANSI 835" format can be opened via the Claim Payment Master. The program
will display an error message if you select a file in a different format.

Reference: ANSI 835 is the American National Standards Institutes Health Care Claims Payment and
Remittances Advice Format.
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Getting Started 11

Browse For Folder

. Confiquration -~
# . Logs

. Samples

. Scripks

HIPAS, Claim Payment Masher

. Corfiguration

I.I!IE!- =

. Scripks
[+ HIFAL Claim Stabus Responder
2 HIFALS, Eligibility Responder

L HISS & Dvaarnd s, B sasrveerd Sortor

(I o [)cm|

The "Browse for Folder" popup

4. Click on the "Run" button to send all files from the folder to the destination.

Note: The pre-defined settings will be applied. To print the files to image, configure the settings. See
also: Configuring Program Options[ 18), Doing Image Setupl[ 43\

HIPAA Claim Payment Master - G4bit

File ‘iew DataExport CodeSets

ACHCIR

~ Dutput Mode
" Printer

™ Screen

* Image File

[T Data Import
Counter
EDI flez

O —
O —

Run ?

The "Run" buttons

5. The displayed "Processing Results” popup will report about operation results.
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12 The HIPAAsuite Claim Payment Master

2.4  Explaining HIPAA Claims

The HIPAA Claim Payment Master enables you to understand electronic remittance
advices by translating HIPAA code sets into meaningful words. The HIPAA Claim Payment
Master translates the code sets and orders the information so that you can see exactly
what payments were made and which deductions taken.

The top part of the form contains:

e The sender and receiver of the transaction, that is the payer who paid the claim.

Explanation of Payment

[ Fayer Great Benefit Plan \ 22 DR MARCUS JWELBY
100 MAIN STREET 55 HIGH STREET The recevenof
KANSAS CITY, MO 64108 | The sender of the SEATTLE, WA 98123 the transaction
Pay Method: Check transaction Bark ID: Vv
Account # —"‘ Arcount #;
Chklss JEFT Date: 05/18/2002 Total At $175.00
\FtayerID: Check/iEFT Mo: 16588

The sender and receiver information of the 835 transaction located at the top
Further, you can find the following data:

e Patient information

¢ Provider information

¢ The claim level information

¢ The claim line adjudication

¢ Service line information

Summary information is displayed upfront, and each claim listed with the adjudication
information and service line information structured with all the details found in the EDI

file.
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Getting Started 13

Claim 1 /’

Patient information
| FPatient Name: JOHN P DOE Member ID Number 11122333301 ‘1_ )
| Provider Name:  JOHN WELBY Federal ID 987121234 q—\—f Provider information)

Claim ldentifier: 985019 Status: Processed as Primary DRG Code; =
Total Charge Amt.  $305.00 Facility, Office Control # 229800001
Payment Amt. £175.00 Frequency; DRG Weight
Patient Resp Amt. $15.00 Filling Provider Organization Discharge Fraction: The claim level information
FRecelved: 050472002
Claim Line Adjudication
1| Froc. HC 99244 | Charge: $75.00 IPaid £60.00 | Paid Units: Bundl
Adjustment Reason Group Adjustment Reason Amount
Patient Responsibility 3 - Co-payment Amount $15.00 [ The claim line adjudicatign
Service Date: 050172002
2 | Froc.. HC 81000 | Charge: $15.00 IPaid $15.00 | Paid Units: | Bundl.: M
Service Date: 050172002
3 | Proc.. HC BT088 | Charge: $215.00 | Faid $100.00 | Paid Units; | Bundl,:
Adjustment Reason Group Adjustment Reason Amount Gty
Payor Initiated Reductions | BS - Payment adjusted because coverage/program guidelines were not $115.00
met or were exceeded.
Service Dale: 05012002 | ]

835 transaction information structure

Further you can see more screen-shots of electronic remittance advices.

Clalem ldentfier.  FO801300095 Status: Reversal of Previous Painent DRG Code: BT2

Total Charge Amt.: ($9,959.50) Facility Office

Payment Amt ($8,042.91) Frequency. VoidiCancel of Prior Claim DRG Weight: -1.3783

Control # 20802400235502

Patient Resp Amt..

Filling: Medicare Part A

Discharge Fraction: 851

[ Wedical Record ID 0000802659 |
[ Received 172472008 |Qta'|ement Start 1132008 [Smemem End 11162008
[ Coverage Amount (49,959.50) |
[ Covered-Actual: -3 |

The claim level information with 1 REF segment, 3 DTP segments, 1 AMT segment and 1 QTY segment

Medicare Inpatient Adjudication

Covered Days or Visits Count ] | Claim DRG Amount

(58,042.91)

Fermark. MADZ I you do not agree with this determination, you have the right to appeal. You must file a written request
Tor an appeal within 180 days of the date you receive this notice. Decisions made by a Quality Improvement
Organization (Q10) must be appealed to that QIO within 60 days.

Medicare Inpatient information from the MIA segment

Claim Disproportionate Share Amount ($1,371.32) Claim PPS Capital Amount ($560.98)
PP2-Capital FSP DRG Amount ($403.48) PPS-Capital DSH DRG Amount 1543.57)
Cost Report Day Count -3 PPS-0Operating Federal Specific DRG Amount ($5,786.18)
Claim Indirect Teaching Amount ($324.43)

On the following screen-shot, the Procedure Code is in the first top cell on the left. The
"HC" stands for "HCPCS" codes which includes all HCPCS, ICD-9 and CPT codes. Other
possible codes are "AD" for dental claims or "IV" for Home infusion codes and "N4" for
NCPDP drug codes.
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14 The HIPAAsuite Claim Payment Master

Adjustment Codes are translated into their descriptions, making it easy to understand
the reasons behind any adjustments.

1 |Froc. HC:09244 [Eharge $75.00 |F'a|d $60.00 |F'a|r_i Units [Bundi
Adjustment Group Reason Armt QY
Patient Responsibility Co-payment Amount £15.00
Service Dale: 0501,2002
2 |Froc HC:B1000 | Charge: $15.00 |F‘:|||:1 $15.00 |F‘:|u:i Units | Bundl,
Service Date; 0501,2002
3 [Froc. HC:B7088 [E‘hargﬁ' 1£215.00 |F':=ud $100.00 |F':=uii Units [Bund
Adjustrment Group Reason Armt Gty
Payor Initiated Reductions Payment adjusted because coverage/program guidelines were not met or w $115.00
ere exceeded.
Service Dale; 05012002 | |

The line level information for a claim with 3 lines

Summary information contained in TS3 and TS2 segments can extend over multiple
claims. The HIPAA Claim Payment Master will begin a summary range with a bracket and
then show the summary information before listing the claims.

Provider Summary Information for the following 7 Claims

Provider ID 1154377166 Facility Type Code 11

Figeal Period End Date 06/30/2008 Total Claim Count 7

Total Claim Charge Amount ($43,266.25) Total Covered Charge Amount (4.

Total Provider Payment Amount ($16,367.74) Total Contractual Adjustment Amount (2 Summary range

Total Mon-Lab Charge Amount ($37,391.25) Total Deductible Amount ($2, beanmg with a
l bracket

Total DRG Amount ($19,343.74) Total Federal Specific Amount ($13,

Total Hospital Specific Amount ($3,468.66) Total Capital Amount ($1‘3;>M

Total Indirect Medical Education Amoun{$766.10) Average DRG Lengih of Stay 4.08

Total Discharge Count 1 Total Cost Repord Day Count -6

Total Covered Day Count -6 Average DRG weight - 4652

Tolal PPS Capital FSP DRG Amount  ($1,183.82) Total PPS DSH DRG Amount ($109.49)

Claim 2

Beginning of the summary information block

Summary information is started with a bracket. At the end of a summary range is
another bracket.
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2.5

3 [Froc. NU D259 [Charge: $927.50 |Paid $0.00 [Faid Units [Bundi
Adjustment Reason Group |Adjustment Reason Arnount Gty
Patient Responsibility 26 - Expenses incurred prior to coverage. $927.50 83
Service Date: 11132009

4 |Froc. NU 0300 |I’:harg9 $2,678.00 |Pau:1 $0.00 [Paid Units: |E|und|
Adjustment Reason Group  |Adjustment Reason Armount Gty
Patient Responsibility 26 - Expenses incurred prior 1o coverage. $2,678.00 22
Senvice Dale 111132009 | |

5 |Froc.: NU 0450 [Gharue $1,542.00 ]F'ald $0.00 [Faid Units: [Elundl.
Adjustment Reason Group  |Adjustment Reason Arnount Gty
Patient Responsibility 26 - Expenses incurred prior to coverage. $1,542.00 |3
Service Dale: 11/1372009 | |

— End of Summary Range

Summary range
ending with a
bracket

End of Summary information block

Requesting a Trial Extension

Once your trial period has expired the application will stop working. If you need to
continue your trial of the product, then you will need to send your request to the support
team. Follow the instructions below.

1. Launch the application.

2. Click on the "Ask for trial Extension” link on the displayed window.

© 2012



16 The HIPAAsuite Claim Payment Master

Q License

HIPAA Claim Payment Master

2.0
!hl,[t] remaining for trial 1]

Thiz iz & full funclional evaluation. You are free 1o evaluate thiz demo.

You will have to purchase this sofbware if you want to continue uging it
after a free evaluation has expired.
R eqistiabon Mumber:

123456789 [ oder | Regiter |

The "Ask for trial extension” link

3. Clicking on the "Ask for trial Extension” link will create an email to HIPAAsuite with the

registration number so they can then create the extension key. For example, this will
open Outlook with the following data inserted:

e To: info@HIPAAsuite.com

e Subject: [HIPAA Claim Payment Master][123456789]: Request for trial extension
key

* Message: Volume ID: 123456789

HIPAA Claim Payment Master][283AEFTA]: Request for trial extension key - Message (HTM.. = X

Message

Tou. | |:"|I‘n EHIPAAsUite. com
=" |
send cea |

Subject:

|:HIPA.= Claim Payment Master][2834EF7A]: Request for trial extension key

Volume ID: 123456789

(L5

The trial extension request email

4. The response from the support team should includes an activation key.

5. Once you have the activation key, click "Register” on the program welcome window.
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License

The "Register” button

6. Paste the activation key into the field on the Registration Form and then click
"Register.”

r e

TSI A— ‘

The "Registration Form" window with entered license key and highlighted "Register” button

7. The success message will appear in the "Result” border.
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18 The HIPAAsuite Claim Payment Master

Q Registiation Form

License Registration Form

LicenseKey  [11111-11111-1111-1111

Register I Claze

Result

Thank you fior evabuating HIPAS Claim Payment Masted

This iz & full lunctional version of HIP&& Clam Payment Master for evaluation use only.
Thiz evaluation version expires in 15 days
EDI_Exchange component is not registersd.

The license activation result
Click "Close."

8. Once the license key has been entered, click "Try" on the welcome window to continue
using the program for another 15 days.

Q License E

HIPAA Claim Payment Master

2.0
Day(s) remaining for trial 15 _
Thiz iz & fully funclional evaluation. You are free to evaluate thiz demo.

‘fou will have to purchase this sofbware if you want to continue usging it
after a free evaluation has expired.

R egistiation NMumber:

123456789 (" 1y [} oue |[ Regster |

 ——

The "Try" button

3 Configuring the Application

3.1 Configuring Program Options

To configure the program options, select Setup » Options in the main menu.
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'."'- HIPAA Claim Payment Master - G4bit
Fle View DstaBxport CodeSets Image(| Setup |JEDIExchange Help

B S . [0 Optons |

Company Sebup
‘ Create Company Setup Table

| -~ Dutput Mode -
The "Options” menu

Alternatively, you can click on the "Setup” button located on the main toolbar.

s HIPAA Claim Payment Master - 64bit

File View DstaExport Code Sets Image Setup EDIExchange  Help
@ .9 O
[ Liﬂh

The "Setup” button

The following screen will appear.

~ Update ~ Log all File Processing
I_ - .
™| Mever check for update Log all Froceszing except Viewing
Record errars only to log. Mo Pop-ups

- Display Option 1 [ Document Color

OnS On P
" One Page par Claim r,;; c;i? nf;- a;:;
& (One Claim after another " Black " Black
- Processed Files

' Leave in Flace T Move T Delste
b i File Directory

— Outbox Directory Path

Save Help | Cancel L

The "Options” window

You can configure the options described below.

Once you have finished editing the options, click "Save."

Update

The following option is available:

e Never Check for Update — Select this option in order not to automatically
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connect to HIPAAsuite.com server and check for program updates.

Log All File Processing

The HIPAA Claim Payment Master has the ability to keep a log of EDI file processing. The
log writing is mandatory in the program. See uﬂl%ﬁ.

The following option is available:

¢ Log All Processing Except Viewing — Manual operations other than viewing on
screen will be logged.

Display Option
The following option is available:

¢ One Page per Claim — Select this option to put the image of a single claim on
one page or a single image file. In the following image, you can see the second
claim of a payment. The header information is repeated on each page. If this
option is selected, then you can specify the rule for giving the names to your
image files (see Doing Image Setupl4o), "Individual Image Filename" options).

¢ One Claim after Another - Select this option to list the claims one after the

other. In the following image, you can see that one claim is displayed after the
other.

B T et
Piint « = [
Explanation of Payment ; B
P Y/ Explanation of Payment
From. Mutual of Omaha To HOSPITAL
th Care Service Ctr Wutual of Omaha Plaza From: Mutual of Omah: o JENNY EDMUNDSON MEMORIAL HOSPITAL
fealtn Care Service Ctr Mutual of Omaha Plaza
Omaha, NE 68175
Check BankID
EFTDRE 03232008 $1.84591 #
1o 70090169 EFTDate 0312312006 $1,04591
0 70080169
Claim 2
me BETH MERRITT 10 Number 800482461 ] Claim 1
KEVMIE NERRITY Sousast ] LEORA G NEMECEK 800516666
NEBRASKA METHODIST HOSPITAL 99.9999999 L EORA G NEMECEK 200516605
02121323 o
490345 2006032310100978 & NEBRASKA METHODIST HOSPITAL 999999999
el o 402596838 Status: Processed as Secondary
mt: 44131 Dischar
$44334 F 2006032310100973|
Frequer
Filing. _ Pointof Service
Pad U 1 | ETD
Armount }m
[s89.27 _Claim Line Adjudication
[saei | [ [Proc. HC Misc [Charge: $443.34 [P $26.36 Paid Unis: Bundl
5 271672006 & 77162006 Adjustment Reason Goup_[Ad) g Rmaurtoh
? A JCharce B S0 E2 [ tasscy \‘“‘“ - Gther adjustments 23~ Payment adjusted because charges have been paid by another $35467 |
U5 [AasmenReason o -
[szg0753
R oo Gther adjustments 13- v $6231
Senice St Zi672005 been provi
Seice Start 152005 3172005
Claim 2
[ Patient Name: BETH MERRITT Member ID Number 800482461 ]
[ms: KEVIN P MERRITT Wember ID Number 800482461 ]
Pr © NEBRASKAMETHODISTHOSPTAL  Federa 1D 999999999
402121323 Processed as Primary
o $4,903.45 2006032310100973|
a $1,765.24
Patient Resp At $441.31 Filing. _ Point of Service
" C ] Claim Line Adjudication
The One Page per Claim" mode o RCOPISC P sz P I
Son G Ao aF
[se027
[2-< [s1as1
Senice Start Z167006_[Senice End 21672006 T

"The One Claim after Another" mode
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3.2

Document Color

You have the choice to render the form in red or in black. The following options may be
defined:

Note: The data is always black.
® On Screen - Choose a color for the form when displaying claims on screen.
e On Paper - Choose a color for the form when printing claims.

¢ On Images - Choose a color for the form when saving claims to image files.

Processed Files

Since the HIPAA Claim Payment Master program can be launched by the Window's
scheduler (see Running the Application via Scheduler[32)), it is important to either move
or delete processed files, so that they will not be picked up again. You have the choice to
either do nothing, move the processed files to a specific folder or delete the files:

e Leave in Place - Select this option to do nothing with processed files.
Note: Not recommended.

* Move - Select this option to move the processed files to a specified folder.

* Delete - Select this option to delete the processed files.

Outbox Directory Path

Specify the place where the result files (images, PDFs) will be located.

Selecting a Code Set

EDI relies on transaction code sets. A transaction code is a basic EDI message type. The
HIPAA Claim Payment Master translates HIPAA code sets into meaningful words (a
corresponding longer explanation or description). For example, facility code "25" means a
Birthing Center, gender code "M" means Male.

At the onset of EDI one of the main design ideas was to make the EDI files as short as
possible and to allow different languages to use the same descriptions by reducing long
verbose explanations to 2-3 byte long codes. Computer storage was incredibly expensive
and making any file larger than it absolutely had to was considered wasteful.

The code sets are stored in the file codesets. xm in the confi guration subdirectory:

Windows XP: c:\ Documents and Settings\All Users\Application Data\Hl PAAsuit e\ H PAA
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22 The HIPAAsuite Claim Payment Master

Cl ai m Paynent Master\ Configuration\

Windows 7, Vista: c:\ ProgranDat a\ Hl PAAsui t e\ Hl PAA Cl ai m Paynent Master\ Confi guration\

% C:\Documents and Settings' All Users' Application Data\HIPAAsuite’ HIPAA Claim Payment Master\Co

Address - Configuration
\ Codesets,xmi

B = = %xa

[# u My Documents

= & My Computer
= K (a:) 315 Floppy
=l e (C:) SYSTEM
= I) Documents and Settings
(L Admintstrator
= I All Users
£ 0 Application Data
= ) HIPAAsuite
B 53 HIPAA Claim Payment Master
I Configuration
1) Logs
1) Samples
) Scripks

The Configuration folder in Windows XP

Tip: The folder is hidden.

To view/edit transaction code sets in HIPAA Claim Payment Master, follow the
instructions below.

1. Go to the "Code Sets" item in the main menu.

s HIPAA Claim Payment Master - 64bit

Fle View DataExport | Code Sets |

Image  Seiup
: E AtoE ] C B
: p LI

EDI Exchange  Help

[ For ]
— Dutput Mode QZ
% Priner
" Screen
= Image File

The "Code Sets" menu

2. From the sub-menu, select a code set name. The following menu items are available
via the "Code Sets" menu:
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AtoE
¢ AdjustmentReason
¢ AdjustmentReasonCode
¢ AdjustmentReasonGroup
e AmountQualifier
¢ ClaimStatusCategoryCode
¢ ClaimStatusCode
e CommCode
¢ DateQualifier
e EntityCode
FtoP
e FacilityTypes
e Filing
¢ Frequency
¢ GenderCode
e ID
e PaymentMethod
¢ PlaceOfService
QtoZ
e Quantity Qualifier
e RDMCode
e REFCode
e RemarkCodes
e ServicelD
e Status

e TransType

23
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The following screen-shot illustrates how to select the "PaymentMethod” code set for
display.

(s HIFAA Claim Payment Master - G4bit
File Wiew DataExport | Code Sets | Image  Setup  EDIExchange  Help

AtoE ] . :
B > i gt L2

FroP FacilityTypes

Ottt Mode b KL Filng

% Prirger Frequency

 Sesen Genderode

o)
|:"‘
Image File ] P ethod ]'

; PlaceOfService

The "PaymentMethod” sub-menu

3. The Code Set configuration window will be displayed. Double-click the field to edit it
and type in the new value.

Below you can see such window for PaymentMethod.

The window provides the following information:

e Number of records in codeset — The total number of codes. For example, for
PaymentMethod it is equal to 5.

e Codes and their corresponding descriptions. The codes are indicated in the source EDI
files. The descriptions are displayed instead of codes in the result easy-to-read files.
For example, for PaymentMethod there are the following codes and corresponding
descriptions:

e ACH — Automated Clearing House
e BOP — Financial Institution Option
e CHK — Check

e FWT — Federal Reserve Funds

e NON — Non Payment Data
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PaymentMethod M=
PaymentMethod MNumber of records
in codeset
Save Close | Help 5
Code Description =
r ACH Automated Cleanng House
|BOoP |Financial Institution Option
CHE Check
_F".H-"T _Fsdsralessm Funds
(MO |Mon Payrment Data L
* bl 1
The "PaymentMethod” code set configuration window
4. Click on the "Save" button to save the changes.
Payment™ethod =1 E
PaymentMethod Mumber of recards
in codeset
Save Close | Help [
Code Description =
r .ﬁ.ummaled Clearing Housze
_ BOF _Financial Institution Option
CHE Check
_F".H-"T _Fsdsralessm Funds
(NOM |Men Payment Data L
* =k

The "Save" button

3.3 Accessing Logs

The HIPAA Claim Payment Master can log its activities. This is especially helpful when

running the program automatically through the scheduler (see Running the Application via
Scheduler(s2)).

Notice: To start logging the activity, activate the "Log All Processing Except Viewing" option. See
Configuring Program Options[18).

In case of any problem, the first thing is checking the log, where all actions and all error
messages related to an EDI file are written down and saved.

Follow the instructions below to access the log files for your HIPAA Claim Payment
Master.
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26 The HIPAAsuite Claim Payment Master

Click View » Log in the main menu.

= HIPARA Claim Payment Master - 64bit

File | Wiew |/DataExport CodeSets  Image Sstup  EDIExchange  Help

e A9 9

[ od ] -

The "Log" menu

Log files are simple text files, one for each day that are stored in date hashed folders.
Alternatively, access the Logs folder in the following directory:

Windows XP: c:\ Documents and Settings\All Users\Application Data\H PAAsuite\ Hl PAA
Cl ai m Paynment Master\ Logs

Windows 7, Vista: c:\ ProgranDat a\ Hl PAAsui t e\ Hl PAA Cl ai m Paynent Mast er\ Logs

% C:\Documents and Settings',all Users'\ Application Data\HIPAAsuite HIPAA Claim Payment Master\Logs =10] x|
File Edt View Favortes Tooks Help | -~

Qe - ) - ¥ ffl'mm = Fokders | [i23)-

Address | ) C:\Documents and Settings\all Uisers!Apphcation DakalHIPARsURETHIPAA Claim Payment MasterlLogs\zo1ziMarch =) [£d Go

Folders x 120314.J0g
@ Deskeop Text Document
& £} My Documents e
B My Computer
= L (A 394 Floppy
B e (C;) SYSTEM
=l [ Documents and Settings
# 10 Administrator
= I All Users
= 10 Application Data
= ) HIPAAsuite
= ) HIPAA Claim Payment Master
1) Configuration
B I Lags
2 0 2z
J March
1) Samples
) Seripts
The Logs folder in Windows XP

\ln lm i

Tip: The folder is hidden by default.

Tip: The ProgramData folder contains all your application data, like program settings, user data, etc,
for all of the installed programs on the computer. The ProgramData folder holds the same files that

were contained in the \ Docunents and Settings\All Users and \Docunents and Settings
\Al'l Users\Application Data folders in XP.
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3.4

Within the directory, find a folder for the year you are looking log for. Then find a sub-
folder for the necessary month with files for each day. Double-click a file which has the
name equal to the necessary date. The log will look like this:

i

| 2 12312010 ~] | Getlog Help

Log Opened at 11:19:20 A

Frocezsing of the file c12120805)k.835 began at 11:193:20 A

Remittance Advices will be printed

2 Payments with 1 claims have been printed

Frocessing of the file c121208059)k.835 ended at 11:19:21 A
Log Opened at 17:22:47 A

Procezsing of the file ¢12120809)k.835 began at 11:23:41 AM

Remittance Advices will be printed

2 Payments with 1 claims have been printed

Frocessing of the file c12120809)k.835 ended at 11:23:42 A
Log Opened at 2:21:18 P

Pracessing of the file ¢127120809k. 835 beqan at 2:21:18 PM

2 Payments with 13 claims have been exported

Frocessing of the file ¢12120805)k.835 ended at 2:21:20 P
Log Opened at 2:28:27 P

Frocessing of the file ¢12120809)k. 835 began at 2:28:27 P

2 Paymentz with 13 claims have been exported

Procezsing of the file ¢12120809)k.835 ended at 2:28:36 P
Log Opened at 5:07:38 P

Frocessing of the file ¢12120805)k. 835 began at 5:07:38 P

2 Payments with 13 claims have been exported

Frocessing of the file ¢12120809)k. 835 ended at 5:07:47 P
Log Operned at 5:09:03 P

Procezsing of the file ¢12120809)k. 835 began at 5:09:09 P
Log Opened at 5:11:24 P

Frocessing of the file ¢12120809)k. 835 began at 5:11:24 P

2 Payments with 13 claims have been exported

Processing of the file ¢127120809k. 835 ended at 5:11:34 P
Log Opened at 5:13:40 PM

Frocezsing of the file ¢12120805)k.835 began at 5:13:40 P

2 Payments with 13 claims have been exported

Frocessing of the file ¢12120809)k.835 ended at 5:14:01 P

The transaction log for a specific day

Using the EDI Editor

EDI files are often hard to read, especially if they have no carriage returns and line feeds
to put each segment on a line of its own.

The EDI Editor available in the HIPAA Claim Payment Master replaces all Element

n,n

separators with a star ™", all sub element separators with a colon ":" and all segment
separators with a tilde "~" even if the original file uses different delimiters.

To Open EDI Editor

To access the EDI Editor, select the "EDI Editor” option under "View" menu item.
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HIPAA Claim Payment Master
Fie (| view ) Data Export  Code
Bl woss

The "EDI Editor" menu

Alternatively, you can click on the "EDI" icon on the toolbar to invoke the EDI Editor.

This option is only enabled when you have opened an EDI file[ 5.

HIPAA Claim Payment Master - 32bit

The "EDI Editor” button

The following screen will appear:

Save I

1 ISA™00™ 00~ ZZT 12M456TEGT2D 61044202051 51601004 012298000020 T~ ﬁ
2 (G5 HP™3935387 7669376542002 1026™11357 229800002 %0040 0x 091~
3 ST 835%229800002™

4 BPR*C*175.00*C*CHK' 20020518~

5 TRN*1*16588"1521685100™

£ DTM™405"20020508™

7 H1*PR*Great Benefit Plan™

& N3"100 MAIN STREET™

9 NA"KANSAS CITY"MO"54108~

10 N1*PE*DR MARCUS J WELBY*FI*097854322™

11 N3"85 HIGH STREET™

12 NA"SEATTLE™WA38123™

13 L1~

14 CLP01426808562672"1 1570785 8713082892421~
15 MM 1TQC*1"redacted “redacted ™ "MI*redacted™

16 NMT*IL*1*redacted redacted ™ M"redacted™

17 M 1822 redacted ™ F "redacted™

16 REF*1L*0508042104™

19 SVCADDO140:: - LIMITED EVALUATION"6 0™
20 DTM*472-20080828™
21 CAS*PR™22"48 8™
22 CASCO™M2™18.2~
23 SVCADDO220:INTRADRAL-FIRST FILM*26*0™
24 DTM472=20080828~
25 CAS*PR=Z2Z21.2~
26 CAS'CO"2°4.8™~
27 SVCTADDOZ30: - INTRACRAL-ADDTL FILM=22%0™

29 CAS*PR"22*15.8™
30 CAS*CO*42%6 2™
31 SE"24"225300002™
32 GE*1*22%800002™
33 IEA™*229800002™
3

The EDI Editor window
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To Cut, Copy, Paste

When you right-click anywhere in the text, a context menu will appear with typical test
edit options such as cut, copy and paste.

[ File: 83512.0di

Hﬂhl

1 ISA™O0™ D0~ i 123456739720~ [
2 GS*HP™9998387 766987654 20021026%11356%229300
3 5T*835%229800002~

4 BPR*C*175.00"C*CHK= =20 020518™

5 TRN*1*16588"1521685100™

6 DTM=405=20020509™

7 N1*PR*Great Benefit Plan™

& N3*100 MAIN STREET™

9 NA*KANSAS CITY*MO*64108™
10 NT*PE*DR MARCUS J WELBY*FI"097654322™

11T N3

12 N-!'SEATTLEWA'QE Undo
13 L™

14 CLP*01426808626"
15 NM1*QC*1"redactad
16 NMT17IL*1"redacted™
17 NM1=32*2"redacted
18 REF*1L*0508042 104
19 SVCAD-DO140:::LI
20 DTM=472°20080828
21 CAS*PR"22"48.8™ Find
22 CAS*CO~42m18.2™ Replace
Context menu

Grl@z2eg2421™
|*redacted™
redacted™

ATION"GT*0™

To Find and Replace

The "Find" and "Replace” utilities work as in a common text editor. To use them, right-
click somewhere in the document and then from the displayed context menu select the
"Find" or "Replace” command. Alternatively, you can press Ctrl F simultaneously on your
keyboard to bring the text search utility.

Fodwhat |
Diection
I Match case [{-‘ Up & Down |

The "Find" pop-up

Pressing Ctrl H simultaneously will bring up the Replace utility.
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Replace 2] x|
Fodwhet |
Replace with: | |

Cancel
™ Malchcaze _I

3.5

The "Replace” popup
To Save the Changes

As long as you don't save, there will be no changes to the file.

If you make changes to the file, the "Save" button becomes enabled and you can save any
changes. The HIPAA Claim Master will further work with those changed files, so you don't
have to open the file again.

Notice: Changing EDI files can be a tricky undertaking. You should be experienced in the format of the
835 and understand that an 835 claim file could be a legal document that should not be altered
without the consent of the originator.

[ File: B3512.edi =101 x|
Help (" swve |
1 ISA"O0" "o =ZZ" 12345678920~ 61044 2%020518"1601*U"00401%229800002 0T _-|

2 (GS*HP*9998388 7766987654 200210261 135229800002} *004010X091™
ST*835*229800002™
4 BPR*C*175.00*C*CHK***~*==20020518™
The "Save" button

Using Command Line Arguments (CLI)

In order to run the HIPAA Claim Payment Master from the command line or have it
invoked through another program, it is necessary to pass command line arguments to the
program to instruct it to perform the desired tasks.

Command line arguments are separated by commas.

1. The first command line argument is the filename or the directory path. The program
will automatically decide if this argument denotes a directory or a single file.

2. The second argument is concerned with data export to another database. If the
argument is "Y", then the data will be exported according to the settings.

3. The third argument decides whether image file will be created. A "Y" will cause the
program to create image files.
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4. The fourth argument will send the images to the printer.

5. The fifth argument can contain the printer name, if a printer other than the default
printer is specified. It is important to use exactly the same name as it is listed in
Windows under printers.

Example

A typical command line would be for example:

"C:\ Program Fi | es\ H PAAsui t e\ H PAA d ai m Paynent Mast er\ H PAAd ai nPaynent Mast er . exe"
C.\EDI\ I nbox\ 835, Y, , Y, Lexmark X500 Series

1. In Quotes you can see the path to the executable. The quotes are necessary in
Windows whenever you have a file name with a blank space in it, such as "Program
Files".

Tip: Sometimes you need quotes for the file name, so it is easiest to change directory to C:\ Program
Fi | es\ Hl PAAsui t e\ H PAA Cl ai m Paynent Master and then call the executable.

2. The first command line argument is the path to a directory. Alternatively you could
have the path to a specific file. The program will see if the argument pertains to a file
or a directory.

3. The second argument is a "Y", indicating that the data will be exported.

4. The third argument is blank. It would instruct the program to create image files in
accordance to the setup. See Doing Image Setupl4ol.

5. The forth argument is a "Y". This instructs the program to print the images of the
payments.

6. The fifth argument is the name of the printer to which the output is to be directed.

Using Command Prompt

Follow the instructions below to use the command-line arguments in Windows Command
Prompt.

1. Start a Windows Command Prompt. Go to Start » Programs » Accessories » Command
Prompt.

Alternatively, you can go to Start » Run » type "cmd” without quotes and press <Enter>.

2. Type your command and click Enter.
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3.6

ment Master~HIPAAC aPayaentMas

Lig]

The Windows Command Prompt screen

The command returns a system code which is not displayed to the users:
® -1 means error
® 0 means everything went okay

So, testing the command line requires that you check the lo_g|75'1 In the log, you may see

a message like following:

Processing of 'C/\EDI\Inbox\835" started at 3/12/2012 9:21:11 AM
Printer is not found in system
Processi ng stopped at 3/12/2012 9:21:11 AM

So, the log will help you to debug the command line.

Running the Application via Scheduler

The HIPAA Claim Payment Master can be automated through a scheduler. A scheduler is
software that can be programmed to execute a certain task at a certain time
repeatedly. Windows has such a scheduler built in.

The Windows scheduler can be used to let the HIPAA Claim Payment Master execute in
regular intervals without user intervention. Usually one would let the HIPAA Claim
Payment Master scan a directory and then print, create image files or export the data
and remove the files to prevent duplicate processing.

1. If the task scheduler is installed on your system, you will find it in the "Control Panel'.
To open Scheduled Tasks, click Start » Control Panel » Scheduled Tasks.

Note: In different Windows versions, the way to access the Task Scheduler can differ. Consult your
Windows version documentation.

© 2012



Configuring the Application 33

8 Scheduled Tasks =10l =]
File Edt View Favorites Tools Advanced Help | &
Qeeck - () - :j‘.|f_jm:h | Folders ‘-
Address |4 schedued Tasks B> E
Name = | Scheduls | mecct Run Time | Last Bun Time | Status
|.2] Add Scheduled Task
Other Places & phGooglelpdateTashlserS-1-5-... At 12:07 PMevery ... 12:07:00FM ... Never Couid not skark

@ Control Panel
(L) My Documents
{25 Shared Documents
W) My Network Places

Details ¥

4| |

a =

[z objects

The Windows Task Scheduler

2. Click on "Add Scheduled Task" and the "Scheduled Task Wizard" will guide you through
the setup process.

3. In the first window, read the welcome message and click "Next."

Scheduled Task Wizard x|

This wizard helps you schedule a task for Windows
to perform.

You select the program you want Windows to run,
and then schedule & for a conveniant tims,

Click Neot to continue.

The "Scheduled Task Wizard" window

4. Browse to the Hi PAACI ai mPayment Mast er . exe executable file.
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Scheduled Task Wizard _EI
Click: the: progeam pou want Windows bo fur.
To see more programs, chck Browse.
| Application | Version =]
7Zip Filz Manager 457 -
& Accessibilty Wizard 5.1.2600.551...
B} ACDSee Pro 25
W Address Book 6.00.2900.55...
I 4.dcbe Bridge 53 20
) &dcbe Device Cenbial C53 1,00
Th A el CodmendC maimt Tomsllis 3 TN ED :]
]
[ <Back | neis | Concel |

The "Scheduled Task Wizard" window

By default, the application is located in c:\ Program Fi | es\ HI PAAsui t e\ Hl PAA Cl ai m Paynent

Mast er \ HI PAACI ai mPaynment Mast er. exe

Select Program to Schedule ,,ilil
Look in: [ 3 HIPAA Claim Payment Master o N N A s

!' | Help =L pdf.ico

%) AcroPOF di %] pafsharp.dil
ST || &) AxInterop. AcroPDFLb.dI [] ProjectHiskory bt
SO || %) eaMiracle. LbTIFF.NET.dI %] QimLicenssLib.dil

| %] CustomactionLibeary, di | Thuts.db
= CustomactionLibrary. Instaltstate 8] Trial.rtf

Dezktop

4

| %) ovnamacarra.di

My Documents

&) 1cSharpCode. AvalonEdit. dil
!ﬂlrtemp--ﬁ-u'uF'DFLb-cl
- | %] 1sLicersesn.dl
Mu Com
Iy Compubes ¥ p Toolico
.
‘.I —
My Network File: rame: |HIF‘#ﬁﬂai‘rFq.mﬂdadm.m _:[ |‘||| Open Ij
Places -

Selecting a program to schedule

Click "Next."

5. Type a name for this task. Choose a time interval:

e Daily
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e Weekly
e Monthly
¢ One time only
e When my computer starts
e When | log on
Click "Next."

scheduled Task Wizard x|

Type 2 name forthis task, The task name can be
the same name as the program name.

(EI PAACIaim Payment f-'lasle._-':)

Parfiorm this task:

The "Scheduled Task Wizard" window

6. Enter the name and password of a user. The task will run as if it were started by that
user. Click "Next."”
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Scheduled Task Wizard x|

Enter the name and password of 3 user. The task wil

run as f it wars staded by that usar.

o e
Enter the user name: |L.==er
Enter the password: quouv
Confirm password: Ilili'l-ll
If & password is not anterad, schadulad tasks might
not run.

The "Scheduled Task Wizard" window

7. In the last screen, make sure you have specified all data correctly. Click "Finish" to
save your task.

Scheduled Task Wizard x|

You have successfully scheduled the following task:
2 HIPAAProviderPrinter

Windows will perform this task:

Run at user logon

r Open advanced properies for this task when | click
Firish.

Click Finish to add this task to your Windows schedule.

The "Scheduled Task Wizard" window

8. The scheduled task has been added to the system. Now lets edit the new task and add
the desired command line arguments with the appropriate options. Double-click the newly
created task in the "Scheduled Tasks" window.
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& scheduled Tasks

Fiie Edit Wiew Favorites Tools Advanced Help

=10l x|
L

Qe © - 9| Domet i rae |-

Address [ Scheduled Tasks

| Schedule

| B

| Mt Run Time | Last fun Time | Status

Folder Tasks £

®j Rename this tem
[ Move this em
[ Copy this tem
. Delete this item

The Windows Task Scheduler

e BE 12:07 PM every ...
Fun at wser logon

12:07:00 FM ...
AR user logon

Mewver Coudd niok skark

ewer

9. Enter parameters to the "Run” field after the application path and click "OK." Refer to
Command Line Arguments|_3c§1 for more information.

Example:

"C:\ Program Fil es\ Hl PAAsui t e\ Hl PAA Cl ai m Payment
C:\EDI\ I nbox, Y, ,Y

2x
Task | Schedue | Setings |
& C\WINDOWS ! Tasks\HIPAACIaimPaymant Mastar job
Bun: (Elr HIFAA  aim P aymant Mastar sce” CAED 'ancx."";_\i)

Start in: I C\Program Files'HIPA&sute  HIPAS Claim Paymant Ma
| |
Fh-. a5’ I.JEET H pm‘rmrd:._.

™ Fun only £ logged on
[+ Enabled (scheduled task runs at specified time)

o= | = |

Mast er \ HI PAACI ai mPaynment Mast er . exe"

The "HIPAAClaimPaymentMaster” task window

You can see, the path to the executable is in quotes and then the arguments follow. In
this example, the directory c:\ ebi\ 1 nbox Will be processed. The first "Y" indicates that
the data will be exported. The second "Y" in 4th position indicates that the images will be

printed.
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3.7

4.1

Tip: Logs may be helpful when running the program automatically through the scheduler. See L_oglﬁ.
Troubleshooting Badly Formatted EDI File

After clicking on the "Process” button, you see a message with the following error
message:

This is nmost likely caused by a badly formatted EDI file. Processing will stop.
There are a few reasons why this can happen:

1. The file is not an EDI file. You can open the file in Notepad and check if it starts with
"ISA". When the first 3 characters are not ISA, then it is not an EDI file.

2. The file could still be encrypted.

3. The file is an EDI file, but has extra blocking characters in it. You can instruct the
HIPAA Claim Payment Master to remove them. See Configuring Program Options1s).

Creating Image Files and PDFs

Creating Image Files from EDI

The HIPAA Claim Payment Master displays the EDI document in a page that makes it easy
to read the 835 transactions. You can create image files containing the data that you see
in Screen mode. The following formats are supported:

* TIFF
* PDF

You can create image files manually or automatically using the command line arguments
and Windows Scheduler. Read more in:

e Running the Application via Scheduler/z2)

e Using Command Line Arguments (CLI)[ 0]

Before creating image files, make sure all settings are defined correctly. Read more in:

e Doing Image Setupl4o]

e Adjusting Image Options[ 42

e Configuring Image Index| s4]

¢ Creating the Image Index Table[ 43]
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Follow the instructions below to create an image file from EDI file.

Notice: The image file will be created based on the pre-defined settings. Read more in Doing Image
Setupl 40), Adjusting Image Options[42), Configuring Image Index[ 42\,

1. Open an EDI file or directory containing the EDI files in the HIPAA Claim Payment
Master. Read more in Processing a Payment Advice Filel 5], Opening a Folder
Containing EDI Files/ 9.

s HIPARA Clain Payment Master - b4bit

File Wiew DataExport CodeSets Image Setup EDIExchangs  Help

=) > s 9 O

The "Open document” button

n HIPAA Claim Payment Master - G4hbit

Cpen Sample File
B open %
Open Direckory

Seleck Printer

Exit

The "Open Directory” menu

2. Select the "Image File" option in the "Output Mode" block.

— Dutput Mode
" Printer
" Sereen

@Iw Fie

The "Image File" option

3. Click on the "Run” button.
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h HIPAA Claim Payment Master - 64bit

File ¥iew DataExport CodeSets

JCHCI

~ Dutput Mode
" Printer

i Sereen

% Image File

[ Data Import
~ Counter- :
coifies [
C —
Coms [ ]

Run ?

The "Run" buttons

4. The "Processing Results” window displays the report. You can find the resulting TIFF or
PDF files in the specified folder.

Processing Results

Processing of the file 8351 .edi began at 2/29/2012 3:46:58 AM

Fayment
The file(CAUsersyv'oung\Desktopy83501 _3_pd) has been created
1 Payme T claims have been imaged e

Frocessing of the file 8351 edi ended at 2‘,-*25.1‘__2\0',!'/

Prucass;lirrnfn::-: file 83612 adi hegf_m at 2/29/2012 3:45?& Result Files

The file(CAUsersir'oung\Des kmp"lSSEIE.p@‘ nat
1 Paymentswith T claims have beenimaged |
Frocessing of the file 83512 edi ended at 2/23/201 &+

The "Processing Results” window

4.2 Doing Image Setup

Before proceeding with image export, do the image setup as described below.

Select Image » Image Setup in the main menu to access the "Image Setup” window.
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"".. HIPAA Claim Payment Master - G4bit

File ‘Wiew DataExport Code Sets( | Image | Setup EDIExchange Help

E _..' = Image Vievser '

-
L __ Image Setup ]|
~ Dutput Mode Image File Options
& P
SRR Image Irdex File Options
= Screen Create Image Index Table

The "Image Setup” menu
The following window will appear:

Image Setup M= B
~Image File Location )

Output Directory For Image Files

[DAEDOUtput 1... ]
Individual Image Filename™ Image Format
o TR a— % TIFF Format " POF Format
' Patient Last Mare ™ Clair ~ Color On Images
0 R IR Ard ey * i * Red " Black
e : ; Image folder options
Indridual Image Filename settings &
are active only if Dizplay option is * MNone
setto "One Claim per Page' in | Sub-Folders for) Month and D
Options, Othenwize prograrm creates A A O R
ane Image file for all Clairms, " Sub-Folders for vear and Week

" Sub-Folders for Year and Day

| Save I I-.Ielp I Cancel | 4

The "Image Setup” window

You can set the options described below.

Once the options have been set, click "Save."

¢ Image File Location — Determine the destination folder where the images will be
stored.

¢ Individual Image Filename — These settings are active only if display option is set to
"One Claim per Page" (see Configuring Program Options|1sl). Otherwise, the program
creates one image file for all claims. You have three choices for the generation of
image file names:
e Claim Identifier (CLP_01) — The result file name will be comprised of the Claim

Identifier in the format like this: "CLP_01." Example: 8351 1_4. pdf.

o Patient Last Name *Claim ID — The result file name will combine the patient name
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with Claim ID. Example: sm TH_985019. pdf .

« Bill Provider ID * Claim ID — The result file name will combine the billing provider's

ID with Claim ID.

¢ Image Format — Choose whether to create PDF or TIFF files.

e Color on Images
You can select red or black color.

¢ Image Folder Options — When you create a lot of images, it is important not to place
them all in the same folder. Microsoft Windows has issues handling more than 1000 files
in a folder. That is the reason why the HIPAA Claim Payment Master can hash the
image files over many sub-folder. You have the following choice to use:
* None — Default value.

e Sub-folders for Year-Month and Day — The sub-folders will be created within the

Image File Location. Example: \ 2012\ February\ 29\ .

=1 |3 PaidClaimImages
F ) 2009
= ) 2010
=1 | February
-
L 19
(20

The folder structure in "Year, Month and Day" mode

e Sub-folders for Year and Week — The sub-folders will be created within the Image
File Location. Example: 2012\ 9\ .

e Sub-folders for Year and Day — The sub-folders will be created within the Image

File Location. Example: 2012\ 20120229\ .

4.3 Adjusting Image Options

The size of image files is largely determined by the image quality. The better the quality,
the more information is stored in the image file. You can define the quality of the image
and the image size in the "Image Options."

Select Image » Image File Options in the main menu to access the "Image Options”
window.
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:'- HIPAA Claim Payment Master - G4bit

File ‘iew DataFxport CodeSets. | Image [} Sstup EDIExchange  Help

@ - Image Viewser P

Image Setup
Dutput Mode || Image Fils Options “
o
SR Image Index File Options
" Screen Creabe Image Index Table

The "Image File Options” menu
You can define the image options described below.

Once the options have been set, click "Save."

Options for TIFF

e Color Depth — You can change color depth of the image (black / white, 4 bpp /
8bpp / 24bpp / 32bpp).

Note: TIFF in Window's GDI library does not work with 16 bpp (bits per pixel). Color depths set lower
then 16 bpp results in some losses in image quality.

Reference: The black-and-white (bi-level) image means that for each pixel (picture element) in the
image we do not need three bytes as in the true color image (over 16.7 million colours), but only one
bit that is 1/24 part of the pixel size from the true colour image. The one-bit pixel can express only
black or white colors, nothing more.

e Compression Algorithm — You can use compression with TIFF files: LZW and
Packbits are used for all Colors, CCITT4 for black-and-white.

¢ Photometric Interpretation — For the black-and-white and grayscale images (when
"Black/White" or "4 bpp" options are selected as color depth), you can specify the
intended interpretation of the image pixel data. Select one of the following options:

e White is Zero — The minimum sample value is displayed as white.
e Black is Zero — Default value. The minimum sample value is displayed as black.

¢ Image Resolution — You can change horizontal and vertical resolution of images
from 96 to 300 dpi (dots per inch). Default resolution is 200 dpi.

Note: Theoretically we could use even higher resolutions, but it will slow down processing significantly
result in approximately the same result in quality.

Options for PDF

e Use Content Compression — Checking this option does result in considerably smaller
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files.
— Dptions for TIFF :
lor th; Compression; Phatomatn Image Resolution:
T Blackiwhite & L7w S Horizontal resolution; 200 dm
 Wihike Tor |
T 4 bpp " Packbits : e _.I = P v
= Blac B
£ oo Gr ick 5
© 8bpp [ Group 2 ¥ Vertical Resobution = Horisontal Resolution
~ 24 bpp ~ . Vertical rezolution: 200 dpi
C 32bpp CITT 1.6 f
— Dptions tor PDF Set default vales | Help |
™ Use content COMNpression
Save | Cancel )L
The "Image Options” window
4.4  Configuring Image Index

Document Management Systems with image libraries often require some basic
information together with the file path to the image. The HIPAA Claim Payment Master
can create such an index through ODBC into any database, independent of the database
used for file downloads.

Select Image » Image Index File Options in the main menu to access the "Image Index
Configuration” window.

".- HIPAA Claim Payment Master - G4bit

File View DataExport CodeSets|| Image | Sebup  EDIExchange  Help

E - Image Viewer b
_ Image Setup |
- Dutput Mode Image Fike Options
e pa
Batet |: Image Inde:x File Options ]
© Screen | Create Image Index Table

The "Image Index File Options” menu

You can define which fields to include and configure your database settings. Here are all
options:

Create Image Index

Check this option to create the image index. Select one of the following options to
specify the format:
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e ASCII Text File — The image Index File is an ASCII text file that can be created
together with claim images. It will contain tab-delimited fields and have one line
per claim.

In the "Text File with Image Files Path” field specify the output directory for image
index. Click "Browse" to select the destination place.

Note: The image index ASCII file currently works only when you save individual images for each claim.

Image Index Configuration =10] x|
¥ Create Image Index @ascn Text File

" Database Export

— Text File with Image Files Paths
The image Indeo Fils is an ASCH text file that can be created together with claim images. & will
contain tab-delimited fiekls and have one ine per claim

Output Directary for Image Index
(!C hidx }

The "ASCIl Text File" option

Browse
Save I

Then click "Save."

e Database Export — Select this option to save the image index through ODBC into
any database, independent of the database used for file downloads. The database
setup is similar to the database setup for the export of claim payment data. Specify
the following database connection parameters:

e Database Type

e Database Server Name or DSN
e Database
e Username
e Password

¢ Image Index Table Name
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& Image Index Configuration Inlﬂ

|ODBC Connection = |
Data Source Name Password
{mysaql |
Database Image Index Table Name
| edi_835imageindex
Test Connection | Save Database Connection | ihe image index Table
through a seperate scree

The "Database Export” option

Once all database connection parameters have been specified, click "Test Connection”
to verify the connection.

..'! Image Index Configuration __.]D_l_!l

™ Create Image Index " ASCH Text File

~ Database Connection Parameters

Database Type LIsemame

|ODBC Connection = [

Data Source Name Pasgword

mysqgl |

Database I Index Table Name

| odi_835imageindex
:- Test Connection |} Save Database Connection I the Image Index Tabie

The "Test Connection” button

The configuration is correct if you receive a message like this. Click "OK."

The success message

Then click "Save Database Connection.”
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[® Image Index Configuration __E_lgl_zl
™ Create Image Index " ASCH Text File
* Database Export
~ Database Connection Parameters
Database Type LIsermname
|ODBC Connection =
Data Source Name Password
Imysal |
Database Image Index Table Name
| |edi_835imageindex
You can create
Test Connection (Sm Database Connection the Image Index Table
through a seperate screen

The "Save Database Connection” button

To create the image index table, click on the "You can create the Image Index Table
through a separate screen.” See Creating the Image Index Table 49,

Fields to be included in Image Index File

You can select the fields that get imported into the image index by selecting the check-
boxes in front of the field names.

Fields to be included in Image Index File

|»

Test Field Configuration |

Save Field Configuration |

Close |

4

The fields to be included in Image Index File

Tip: As with the other field selectors, you can change the field names by clicking on them. This is
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helpful if you have an existing database that you want to access.

Chan-giﬁé the- field names

For Database export, you can test the fields configuration by clicking on the "Test Field

Configuration” button.

~ Fields to be included in Image Index File
Header

EDFilsname
[#] mageFienams
el Claimbio
A TradingParinerD
[#] PayDate
[ Fayerid
[ rayeriame
[ PayesD
[#] PayesLast
[ SubscriberLast
A SubscriberFirst
[ SubscriberD
[ PatientLast
[#] FatientFirst
[#] EatientD
AmountCharged
[ AmeuntPaid
FA Sarvicalatatram

Select All

o[

(: Test Field Configuration _])

=

Save Field Configuration I

Close

The "Test Field Configuration” button

You will receive a message like this. Click "OK."

x|

i

¢
:
g

)

The success message

When ready, click on the "Save Field Configuration” button.
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~ Fields to be included in Image Index File -
Header

[+ EDFiename
[ mageFiename
[ craimtio
[ TradingParinerD
[ ayDate
O] Payor Test Field Configuration |
[ rayortiame
[#] Payeed
[ FayeeLast (,- Save Field Configuration 1)
A SubscriberLast = =
A SubscriberFirst
B4 SubscricerD
E PatientLast
B PatientFirst
[ PatientD
[ amountCharged

[ ampuntPaid =

EA € s simaliahak rnm

. Select Al | Select Hone |
Close

4

The "Save Field Configuration” button

Once all image index options have been defined and saved, click "Close."

Com ),

el

The "Close" button

4.5 Creating the Image Index Table

To create the table for the image index, follow the instructions below.

1. Select Image » Create Image Index Table in the main menu.

s HIPAA Claim Payment Master - 64bit

File Wiew DataExport CodeSets(| Image | Setup  EDI Exchange  Help

E -’ — Image Vievesr
_ Image Setup
- Dutput Mode Image File Options
(" Printer Image Indes File Options
 Sereen 'E__ Create Image Index Table

The "Create Image Index Table" menu

2. The following window will appear.
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5| Create Image Index Table

~ Databaze
* Microzoft SAL Server
 MySQLGeneric

Image Index Table script:

CREATE TABLE [dbo) [edi_S35mageindex)
ID7) [bagint] IDEMTITY1,1) MOT WULL,

|EDHFileriame] [varchar](1100) CEFALULT MULL,
[ImageFilename] [verchar)(100) DEF ALULT MULL,
[Claimida) [varchar](35) DEFAULT NULL,
[TradingPartnerD] [char]i15) DEFALULT MULL,
[Praylabe] [date] DEFALLT MULL,

(PavioriD] [varchar)i 25) DEFALLT MULL,
[Payorhiame] [varchar {503 DEFALLT MULL,
[PayesD] [varchar)(25) DEFALLT MULL,
[Payveel azt] [varchar](E00) DEFALLT MULL,
[SubsscriberiD] [varchar)15) DEFALLT MULL,
[SubscriberLast] [warcharj50) DEFAULT MULL,
[SubscriberFirst] [warcihar)(33) DEFALULT NULL,

[PatierdiD] [varcher)(15) DEFAULT NULL,
[PatiertLast] [varchar)(600 DEFALILT MULL,
[PatierdFirst] [warchar)(35) DEFAULT NULL,

[ServiceDateFrom) [date] DEFALLT NULL,
[ServiceDateTa] [date] DEFALLT NULL

) ON [FRBAARY]

Help |

[AmauntCharged] [decimall10, 2) DEFALLT NULL,
[AmountPaid) [decimall(10, 2) DEFALLT NLLL,

Save

Execute Script

The "Create Image Index Table" window
3. Select one of the necessary options:
* Microsoft SQL Server

e MySQL/Genetic

4. Then make sure the image index table script is correct.

© 2012




Creating Image Files and PDFs 51

:i":‘ Create Image Index Table

-~ Database
i -
(& Microsoft SOL Server
' MySQLGeneric

Image Index Table script:
CREATE TABLE [dbo] [edi_83Smageindex)

[I07) [odgint) IDERTIT (1,17 MOT NULL,

[EDHF leriame] [varchar 100y DEF ALLT MULL,
(IrmiageFibeniame] [varchar)(100) DEF AULT MULL,
[Claimida] [varchar](35) DEFALULT NULL,
[TradingPartnerD] [char]i15) DEFALLT MULL,
[PavDate] [date] DEFALILT MULL,

[ParvoriD] [varchar)(25) DEFALLT MULL,
[Pavorhiame] [varcharj(60) DEFALLT MULL,
[PayesD] [varchar)(25) DEFALLT MULL,
[Pavyeelast] [varchar)(E07) DEFALULT MULL,
[SubscriberiD) [varchar)15) DEFALLT MULL,
[SubscriberLast] [warcharj50) DEFAULT MULL,
[SubscriberFirst] [varchar)(35) DEFALLT NULL,
[PatierdiD] [varcher)(15) DEFAULT NULL,
[PatientlLast] [warchar){500 DEFALLT MULL,
[PatiendFirst] [warchar)(35) DEFAULT MULL,
[AmountCharged] [decimal)10, 2) DEFALLT MULL,
[AmountPaid] [decimal)(10, 2) DEFALLT MULL,
[ServiceDateFrom] [date] DEFAULT MULL,
[ServiceDateTa) [date] DEFALLT MULL

1 ON [PRIMARY]

Help | Save Execute Script

The "Create Image Index Table" window with the "Microsoft SQL Server” option selected
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:i":‘ Create Image Index Table

-~ Databasze
I_‘-f'f\ Microsoft SQL Server
\ MySQL/Generic

Image Index Table script:

CREATE TABLE “edi_S3Smageindex” (
“ID" bagint( 200 MOT NULL AUTO_INCREMENT
“EDIFBeriame" varchan(1000 DEFAULT NULL,
“immpeFlename varchar(100) DEFAULT MULL,
"Claimbo” varchan(35) DEFAULT MULL,
“TradingPartnerD’ char(15) DEFAULT NULL,
"PayDate” date DEFAULT MULL,
“PanvoriD’” varchan25) DEFAULT NULL,
*PayorMame” varchar(E0) DEFAULT NULL,
“PayesiD” varchar{25) DEFALLT NULL,
“Payeslast varchar(60) DEFALULT NULL,
“SubscriberiD” vancher(15) DEFAULT MULL,
“SubscriberLast” varchar(B0) DEFALLT MULL,
“SubscriberFirst” varchar35) DEFALLT MULL,
"PatiertiD’” varchar(1S) DEFALULT NULL,
"PatieniLast” varchar(60) DEFALLT MULL,
"PatierdFirst” varchar(35) DEFALLT MULL,
*AmountChanged decimali10,2) DEFALLT MULL,
" AmountPeid decimal(10,2) DEFAULT NULL,
“ServiceDaleFrom” date DEFALILT MULL,
“ServiceDalaTo” dale DEFALLT MULL,
LBGILE KEY "ID" (CID)

) ENGIME=InnoDE AUTO_MCREMEMNT=4 DEFALLT CHARSET=141E,

Help | Save Execute Script

e
The "Create Image Index Table" window with the "MySQL/Generic" option selected
5. Click on the "Execute Script” button.
Help | Save ” Execute Script I}
Y

The "Execute Script” button
Then you will receive a notification like this. Click "OK."

o
Table successfully areated
(. )

The success message

6. Then click "Save."

Example
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5.1

You can use the following MySQL/SQL script:

CREATE TABLE " edi _835i magei ndex" (
1D bigint(20) NOT NULL AUTO | NCREMENT,
"EDI Fi l enane” varchar (100) DEFAULT NULL,
"I mageFi | ename”™ varchar (100) DEFAULT NULL,
“ClaimNo™ varchar (35) DEFAULT NULL,
“Tradi ngPartner! D char (15) DEFAULT NULL,
" PayDat e date DEFAULT NULL,
“Payor | D' varchar (25) DEFAULT NULL,
" Payor Name® varchar (60) DEFAULT NULL,
" Payeel D' varchar (25) DEFAULT NULL,
" PayeelLast”™ varchar(60) DEFAULT NULL,
“SubscriberI D' varchar(15) DEFAULT NULL,
" Subscri berLast® varchar(60) DEFAULT NULL,
" Subscri berFirst® varchar(35) DEFAULT NULL,
“PatientI D varchar(15) DEFAULT NULL,
“PatientlLast® varchar(60) DEFAULT NULL,
“PatientFirst® varchar(35) DEFAULT NULL,
" Anpbunt Char ged™ deci mal (10, 2) DEFAULT NULL,
" Ampunt Pai d° deci mal (10, 2) DEFAULT NULL,
“Servi ceDat eFrom date DEFAULT NULL,
“Servi ceDat eTo” date DEFAULT NULL,
UNIQUE KEY "ID ("ID)

) ENGI NE=I nnoDB AUTO_| NCREMENT=4 DEFAULT CHARSET=utf 8;

Tip: Make sure you use a correct symbol * and not ' in the script.

Tip: If you encounter errors running the script on MySQL or other database systems, then modify it
until it works or consult with your database administrator to make the modifications. SQL Scripts share
over all platforms a lot of syntax, but still each flavor demands its own adjustments.

Using the Database
Exporting the Data

The HIPAA Claim Payment Master can export the data contained in a 835 Payment Advice
to any ODBC aware database such as Microsoft SQL Server, Oracle, AS400, etc. The
structure of the 835 transaction is quite nested and in order to truly export the data in a
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normalized manner it is necessary to create 6 different tables with the following
relationships:

| edi_providerleveladjustments

) . %o
edi_claimpayment PaymentlD
Tio = ProviderlD = _

gParinedD FiscalPeriodDate edi_claimleveladjustments |
EDIFilehame AdjustmentReason WD
Eiledate Adjustmentidentifier c|a-|m‘]p

. ) AdjustmentAmount AdjustmentGroup
TransactionHandlingCode S

AdjustmentReason )

PaymentAmaount - 2 Adjustmentamaunt T
DebitCredit ( : . ~ | . edi_paidclaimlinead)
PaymentMethod edi_paidclaims AdjustmentCity YD
SendingBankNo L) LinelD
SenderAccountio PaymentiD P AdjustmentGroup
PayerlD :'”:i.‘:;r'm | edi_paidelaimlines AdjustmentReason
PayerDivision aalityType i Adjustmentamount
Re:emnuhnkm FiscalPeriodDate . f._,.mm AdjustmentQty
ReceiverAccountio ClaimCount PracedureCode
Effectivedate TOI«IHIIChalg = Revenuelode
CheckNumber ClaimiD AdjProcedureCode
Productiondate Claimstatus ChargedAmount
Payerame ClalmAmayrt PaidAmount
PlaniD Crenmakd UnitsPaid
PayerAddressl PatientResponsiblity UnitsCharged
PayerAddress2 :‘”"’2:’:":’; ServiceDate
PayerCi ayersClaimi FE f—
Pa:uﬂ?;e FacilityTypeCode A;h::"co ot
FayerZip L AftachmentCode
PayerlDNumber MOA LocationMumber
SubmitterlD ot eyl PriorAuthNe
HIN RepricedClaimMum AllowedAmount
MAIC MedicalRecordMum Tax
PayerContact OrigRefhlo RemarkCodes
DmarTaladnm ReceivedDate

The relationship of the tabes involved in the 835 transaction

The data is written to the database once the "Run” button has been clicked and only if
the "Data Import" checkbox is activated.

© 2012



Using the Database

B Hipax Claim Payment Mast

Fle View Databiport C
=L

~ Dutput Mode
Pt

T Screen

&+ Image File

@Daalm‘l
— Counter -
83511 edi

S —

Run = ‘

The "Data Import"” check-box
The "Processing Results” window will display notification about data export.

=10l
Processing of the file 83511.edi began at 3/13/2012 3:00:01 AM

Fayment Records will be exponted

1 Payments with 1 claims have been exported
Processing of the file 8351 .edi ended at 3/13/2012 3:00:.02 AM

The "Processing Results” window
The sequence of actions to setup the data export is the following:

e Setting up Database Connectionlss]

e Creating Tables[ 62!

¢ Viewing the Database Schemal 7o)

e Selecting Fields to Export[71]

e Browsing Exported Datal 76

5.2 Setting up Database Connection

55

The HIPAA Claim Payment Master natively treats a payment advice record as a single
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object. The application extracts the complete payment from an EDI file into its
proprietary data object. It can translate and export this data into any ODBC-compliant
database such as Microsoft SQL Server, Oracle, etc.

Tip: The default fields that come with the product can be extended; customizations are possible.

1. Select Data Export » 835 Connection and Data Fields in the main menu.

s HIPARA Claim Payment Master - b4bit

Data Export | Code Sets

| 835Connection and DataFikds |+

= >

5§35 Payments and Paid Claims
835 Table Creation
35 Database Schema

—

Creabe 335 EDI Files

The "835 Connection and Data Fields" menu

Image Setup EDIExchangs Help

o

2. You will be confronted with the following screen where you can set up the database
connection and enter the names of the database tables.

[ patabase and Field Setup =101 x|
i~ HIPAA Provider Printer Extract Capabilities | [ Fields to be
The HIFAS Provider Printer natively treats a Payment Claims Claim Lines
payment advice record as a single Object. The = O] File Level Data -] [0 PaymentiD [Kew of Payment table] < O ClainlD [Key of Claim T.able] =
HIPAS Provider Printer extracts the complete O TradngPastned D = [ Statistics TS3) O ProcedureCode
Payment data from an EDI file into its propristary I EDIFileNasme [ PiovidedD [0 ReverueCode
data ohject Itcan translate and sxport this data O FicDate I FaciityType O submittedProcedureCode
into any ODBC compliant database, such as & [ FinancisData (BPR Segment] [ FiscalPeiiodDate [ Chargedmount
Micrasoft SOL Server, IBM AS400, Oracle and so [ TiansaciionHandingCode [ ClsnCount D Paidamount
on, The default fields that come with the product or N " O Pasitionins [ UritsPaid
can be extended. Customizations are possible. ayme v
AskVendor for details O DebiCieds OO TotalChaiges [ UnitsCharged
- [ PaymentMethod =-[J Claim Data O ServiceDate
C ion Properti [ SendingBankNo [ ClairiD O ProvidesCantroiblo
Database Type O Sendesccountio O ClamPositiorinFile O tutko
IE Iver [ PayerD i [ ClarnS tatus O AttachmentCode
[ PayerDivision O Clartmount O LocationN umber
Database Server Name [ ReceivingBarikho O ClsinPaid O Pricctutiio ||
[ Receivettcoounito [ PatientRespansbiity [ HealthcarePalicylD
[ EtfectiveDate O lnsissnceType O Alowedbrmaunt
Database | [ CheckNumber or EFT Number ] PayersClainiD (SRR =
Usemame | [ ProductionD ate [ FaciltyTypeCode | Select Al | Select None |
. @ | =0 E";’ "':;"“'m B :ll;\ Provider Level Adjustments
EEEI 'ayerhame
I FiarlD o Payer ID ] GrouporPolicyMum o EW"‘IE (Key of Payment Table)
Payment Table edi_daimpayment O Payertddress1 O Membeddentium m} 1o e .
; [ Payeraddress2 ] PiioeAuthbium ] FiscaPaiodats
Claim Table edi_paidclairms - O AdiustmeniFeason
O PayerCly [ PreDeteminatioriNum D Adiustmernitldentiies
Line Table edi_paidclaimlines [ PayerSiate [ RepicedClaimtum O Adiustrentamount
S O Faveize [ Awthrizationtum =l
S tsfedi_claimleveladjustment [ PayeriDMNumber SekctAl | SekctMone || SelctAl | SelectMone |
s - P — " [ Subsritted D
Line Adjustments |edi_paidclaimlineadi aHn Claim Level Adjustments Line Level Adjustments
Provider Level Adj. [sdi_providerleveladjustments Cnaic (] ClainlD [Key of Claim Table] ] LinelD ey of Clsim Line Table)
[ PagerCantact O AdpstmentGiroup O AdjustmeniGroup
ol catl cfeate the tables through a separate O PayerTeiefon O AdpusimentReason O Adiustmenifteason
scleen O PaverFax = O Adpstmenttmount O Adustmentdmount
Sawe Connection Information | 2| = | LIJ O AdpstmentQty O AdiustmentQty
TestConection | I~ Connection not checked Select Al SelctMone || Sekctat | SekciMone || SelectAl | SelectNone
Test Canfiguration | Save Field Configuration |
Cancel | Help I

The "Data and Field Setup” window

Connection Properties

Tip: If you use ODBC for the connection, you will need to set up the ODBC connection first in the
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Windows » Control Panel ¥ Administrative Tools ¥ Data Sources (ODBC) setup screen. Setting up the

ODBC connection varies from database to database.

£ 10DBC Data Source Administrabor

2

UserDSN  System DSN | File DSN | Drivers | Tracing | Connection Pooling | About |

Syctem Data Sources:
Name | Driver - Add.. |
8358ccess Microzolt Access Diver [
ClaimiPrintesyS 0L MySOL ODBC 351 Divver Remove |
Cuding Senes Access ODBC Drive
HOW_ et Dirrver do Micrasolt Access Corfigune.._ |
HIF&4suteDB IBM Unil sta ODBC Diiver
HIFAAsuteMySOL MySOL ODBC 351 Driver
SOL_ODBC SOL Serves
Test Diriver do Microzoll Access —

Hreme Sample Databaze 2005 Microsolt Access Diver [*r
W Samnls Matahass NE Micrnnenh ﬂmv<rlhir g
A I L4

on thiz machine, including NT services,

#An ODBC System data sowce stores information about how to connect to
the indicated data provider. A System data source is visible o all users

oK Cancel Apply

Help

The ODBC Administration screen in Windows
Define the database connection properties:
e Database Type
e MS SQL Server
e MS SQL Server Integrated Security
e ODBC Connection
e ODBC Connection for Oracle
e Database Server Name
e Database
e Username
e Password
e Payment Table
e Claim Table

¢ Line Table
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e Claim Adjustments
e Line Adjustments

e Provider Level Adjustments

[ Database and Field Setup

— HIPAA Provider Printer Extract Capabilities ——
The HIPAA Provider Printer natreely treats a
payment advice record as a single Object The
HIPAA Provider Printer exiracts the complete
Payment data from an EDI file into its proprietary
data object It can translate and export this data
inta any ODBC compliant database. such as
Microsoft SQL Server, IBM AS400. Oracle and so
on. The default fields that come with the product
can be extended. Customizabions are possible.
Ask Vendor for details.

P 8

|ODBC Connection

Data Source Name

mysq!

Database Itasl

Usemame  [root

Password |

Payment Table  |edi_claimpayment
Claim Table |edi_paidelaims
Line Table |edi_paidelaimlines

Claim Adjustments|edi_claimleveladjustments

Line Adjustments |edi_paidclaimlinead;

‘Qwidar Level Adj. |¢-dl_prwd=rlmlad|uwn=m

Tes! Conmechon [T Connection not checked

e Holp |

The connection properties fields

To create tables in your database, click on the "You can create the tables through a
separate screen” link. For instructions, refer to Creating Tables|62).
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& Database and Field Setup

— HIPAA Provider Printer Exiract Capabilities ——
The HIPAA Provider Printer natreely treats a
payment advice record as a single Object The
HIPAA Provider Printer exiracts the complete
Payment data from an EDI file into its proprietary
data object It can translate and export this data
inta any ODBC compliant database. such as
Microsoft SQL Server, IBM AS400. Oracle and so
on. The default fields that come with the product
can be extendad. Customizabions are possible.
Ask Vendor for details.

~ Connection Properties
Database Type
|ODBC Connection -]
Data Source Name

mysql

Database Itasl

Usemame  [root

Password |

Payment Table  [edi_claimpayment
Claim Table |edi_paideiaims
Line Table |edi_paidelaimlines

Claim Adjustments|edi_claimleveladjustments

Line Adjustments |edi_paidclaimlinead;

Provider Level Adj. |edi_providerleveladjustments

|

Save Connection Information

Test Connection | [T Connection not checked
I Cancel I Help |

A link to create tables

Once the connection parameters have been entered, click "Save Connection Information.”
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& Database and Field Setup

— HIPAA Provider Printer Exiract Capabilities ——
The HIPAA Provider Printer natreely treats a
payment advice record as a single Object The
HIPAA Provider Printer exiracts the complete
Payment data from an EDI file into its proprietary
data object It can translate and export this data
inta any ODBC compliant database. such as
Microsoft SQL Server, IBM AS400. Oracle and so
on. The default fields that come with the product
can be extendad. Customizabions are possible.
Ask Vendor for details.

-~ Connection Properties
Database Type
|ODBC Connection -]
Data Source Name

mysql

Database Itasl

Usemame  [root

Password |

Payment Table  |edi_claimpayment
Claim Table |edi_paidelaims
Line Table |edi_paidelaimlines

Claim Adjustments|edi_claimleveladjustments

Line Adjustments |edi_paidclaimlinead;

Provider Level Adj. |edi_providerieveladjustments

Test Connection | [T Connection not checked
I Cancel I Help |

The "Save Connection Information” button

To verify if the entered parameters are correct, click on the "Test Connection” button.
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=': Database and Field Setup

— HIPAA Provider Printer Extract Capabilities
The HIPAA Provider Printer natvely reals a
payment advice recond as a single Object. The
HIPAA Provider Printer exiracts the complete
Payment data from an EDI file into its proprietany
data object It can translate and export this data
into any ODBC compliant database, such as
Microsoft SGL Server, IBM AS400, Oracle and so
on. The default fields that come with the product
can be extended. Customizations are possible.
Ask Vendor for details.

~ Connection Properties
Database Type
|ODBC Connection =]
Data Source Name

[mysql

Database Iiast

Usemame [root

Password |

Payment Table  |edi_claimpayment
Claim Table |edi_paideiaims
Line Table |edi_paidelaimlines

Claim Adjustments|edi_claimleveladjustments

Line Adjustments |edi_paidclaimlinead;

Provider Level Adj. |edi_providerleveladjustments

Save Connection Information I

([Tt cormain P connection notcheckad

Cancel | Help |

The "Test Connection” button

If the test has passed successfully, you will see the following notification:

B x

Success establshing connection
Payment table verified

Claim table verified

Ling table verified

Claim Level Adjustments table verified
Line Level Adpstments table verified
Provider Level Adjustments table verified

(< )

The success message

61
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Once the test has passed successfully, the "Connection not checked" message changes to
“Connection checked.”

You can create the tables through a separate | You can create the tables through a separate
screen screen

Save Connection Information Save Connection information

m (: Connection not r.he:k) Test Connection @ Connection r.heth@
Cancel | Help | Cancel Help |
3

The "Connection not checked" checkbox

Once you have the database connection defined and tested, you can enter the table
names. See Selecting Fields to Export/[71l.

If you need to create the tables first, then see Creating Tables[e2\.

5.3 Creating Tables

Before data exportls3], you need to create the tables through SQL table statements. You
can do this using the built-in function of the HIPAA Claim Payment Master. Creating
these tables is a quite intimidating task. Once you have your connection defined|ss! and
tested, follow the instructions below.

1. Select the Data Export » 835 Table Creation in the main menu.

s HIPAA Clain Payment Master - G4bit

File  Yiew!| DataExport | CodeSets Image Setup  EDI Exchange
835 Connection and Data Fields L 5
835 Payments and Pald Claims =
_ nupmuu[ 835 Table Creation |
& Brnkat £35S Database Schema
= Sereen Create 535 ED] Files j

The "835 Table Creation” menu

2. The following window will be displayed.
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:L‘.‘ Create Tables
~ Database
& Microsoft SOL Server  © MySQL/Generic

Poyment |  Claims | ClaimLeveladi | ClaimLines | ClaimLineAdi | ProviderLevel Adj |

C:ProgramDataiHIPAASuite HIPAA Claim Payment MasterScripts'ClaimPayments_SOLServer.sql

1 CREATE TABLE [dbo] [edi_claimpayment] ( -
[ID] bigint IDENTITY (1. 1) NOT NULL .
["File Level Data®/
[TradingPartnerlD] [char]{15) NULL.
[EDIFileMame] [varchar](100) MULL.
[FileDate] [date] NOT NULL.
[FileTime] [time] NULL.
] [LoadDate] [date] NULL.
g [LoadTime] [time] MULL,
10 [FinancialData (BPR Segment)™/
1 [TransactionHandlingCode] [char](1) NULL,
12 [PaymentAmount] [varchar](12) MULL.
13 [DebitCredit] [char](1) NULL.
14 |PaymentMethod] [char](3) MULL.
15 [PaymentFormat] [varchar]{10) NULL,
16 [SendingBankiMoCual) [char]{2) MULL.
17 [SendingBankMo] [varchar]{15) NULL.

= N = L B

18 [SenderAccountMo] [varchar](25) NULL

19 [PayerlD] [varchar](50) MULL.

20 [PayerDivision] [varchar](25) NULL.

21 [RecevingBankMoQual] [char](2) MULL.

22 [ReceivingBankMo] [varchar]{15) MULL,

23 [ReceverAccountMoGuall [charl(3) NULL. =

Save Execute Script I

Help I 4

The "Create Tables" window

3. Define the following options:
Database
¢ Microsoft SQL Server
e MySQL/Genetic
Tabs
On the following tabs there are SQL scripts used to create the appropriate tables:
e Payment
¢ Claims
e Claim Level Adj

¢ Claim Lines
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e Claim Line Adj

e Provider Level Adj

Tip: You can modify the scripts so that they run on your specific database.

On each tab, click "Save."”

[ Save H Execute Script ||

Help I

The "Save" button

On each tab, click "Execute Script” to create the corresponding table in the database.

Save ” Execute Script III||

4

Help I

The "Execute Script” button

Once the table has been created successfully, you will see the following notification:

x

Table successhuly created

(I |

The success message

The following screen-shots displays MySQL script to create tables.
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[ Create Tables ol x| |

~ Database
" Microsoft SCL Server @MESQUGanaric

‘:\_ Payment T) Claims | ClaimLeveladj | ClaimLines | ClaimLine Adj | ProviderLevel Adj |

C:ProgramDataiHIPAASuite HIPAA Claim Payment MasterScriptsiClaimPayments_MySOL.sql

1 CREATE TABLE "edi_claimpayment’ | a
*ID" bigint{20) NOT NULL AUTO_INCREMENT,

I"File Level Data™/

“TradingPartner D" varchar(15) DEFAULT NULL.
"EDIFileMame” varchar 1007 DEFAULT MULL.
"FileDate” date DEFALULT NULL.

"FileTime™ ime DEFALILT MULL,

‘LoadDate’ date DEFALLT NULL,

“LoadTime" time DEFAULT MULL,

[*FinancialData (BPR Segment)®/
"TransactionHandlingCode™ char(1) DEFAULT NULL.
"PaymentAmount” varchar(12) DEFAULT MULL.
*DebitCredit’ char(1) DEFALULT NULL.
“PaymentMethod” char(3) DEFAULT NULL,
"PaymentFormat” varchar(10) DEFAULT NULL.
“SendingBankMoCual char(2) DEFAULT NULL.
“SendingBankMo’ varchar(15) DEFAULT NULL.
“SenderAccountMo’ varchar(25) DEFAULT NULL.
"PayerlD” varchar(50) DEFAULT MULL,
"PayerDivision” varchar(25) DEFALULT MULL.
"ReceivingBankMNoCQual” charn(2) DEFAULT NULL.
‘ReceivingBankMo” varchar(15) DEFAULT NULL,
"ReceiverAccountMoCQual” char3) DEFAULT NULL. ll

Save Execute Script I

Help I y

The "Payments” tab

b RO OO =) O N B L RO

JON N s L S

R =l T

Bl Pod P B ek ik
Lad P
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[ Create Tables ol x| |
~ Database = .
C Microsoft SOL Server | MySQL/Generic
Payment {i Claims T Claim Level Adj Claim Lines Claim Line Adj | Provider Level Adj ]
CiProgramDataiHIPAASuite HIPAA Claim Payment Master'Scripts PaidClaims_MySQL.sql
1 CREATE TABLE “edi_paidclaims’ | -
2 “ID° bigint(20) NOT NULL auto_increment,
3 “PaymentID” bigint(20) NOT NULL COMMENT 'Foreign Key',
4 ["Statistics (TS3)"f
g “Providerl D™ char15) default NULL,
B 'Fucili%Type‘ char(3) default NULL.
7 ‘FiscalPencdDate” date default NULL.
8 "ClaimCount” int(6) default NULL.
9 *PositionIinSummary” int(6) default NULL,
10 "TotalCharges™ char(15) default MULL.
11 I"Claim Data™/
12 “ClaimID” varchar(20) default NULL,
13 "ClaimPositioninFile” int(6) default NULL.
14 *ClaimStatus™ char(2) default NULL.
“ClaimAmount” varchar(10) default NULL.
16 “ClaimPaid” warchar(10) default MULL.
17 *PatientRespaonsibility” char(10) default NULL
8 “InsuranceType chan2) default NULL.
19 "PayersClaimlD" varchan50) default MULL.
20 “FacilityTypeCode” char(3) default NULL,
21 “ClaimFrequency” char(1) NULL.
22 "DRGCode” char(4) NULL,
23 "DRGWeiaht” decimali15. 4) NULL =
Save Execute Script I
Help I 4

The "Claims" tab
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[ create Tables
~ Database -
" Microsoft SOL Server * MySQOL/Generic

Payment Claims

C:ProgramData'HIPAASUTte HIPAA Claim Payment MasterScripts\PaidClaimAd)_MySoL.sql

Clainn Level Ad) ] . Claim Lines Claim Line Adj ] FProvider Level Adj I

CREATE TABLE "edi_claimleveladjustments™ |
1D bigint{20) MOT NULL auto_increment,
“ClaimiD” bigint(20) NOT NULL,
*AdjustmentGroup” chan(2) default NULL
5 “AdjustmentReason” char(3) default MULL.
& "AdjustmentAmount” char(10) default MULL.
Adjustmenlﬂt'_f char(2) default NULL.,
UNIQUE KEY "ID" ("ID7)
) ENGIMNE=InnoDB DEFAULT CHARSET=latin1;

Save

El

=

Execute Script I

. Help I

The "Claim Level Adj" tab
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_:,'.. Create Tables
~ Database =~
C Microsoft SOL Server | MySQL/Generic

P

Payment |  Claims | Claim Lmlﬁdj:::; ClaimLines | ) Claim Line Adj | Provider Level Adj |

C:ProgramData'HIPAASuite HIPAA Claim Payment Master'Seripts'PaidClaimLines_MySoL.sql

1 CREATE TABLE "edi_paidclaimlines”
*ID° bigint{20) NOT MULL auto_increment,
"ClaimiD” bigint(20) NOT NULL,
JTEVCT
"ProcedureCodeQual’ char(2) default NULL.

6 "ProcedureCode” varchar(30) default NULL.

7 "ProcedureMadifier1” char(2) default NULL.,

8 "ProcedureModifier?” char(2) default MULL,

9 "ProcedureModifier3” char(2) default NULL,
10 "ProcedureMadifierd” char(2) default NULL,
11 "ChargedAmount” varchar(10) default MULL.
12 ‘PaidAmount” varchar(10) default MULL.
13 "RevenueCode” varchar10) default NULL.
14 “UnitsPaid” varchar(5) default NULL.

15 “SubmittedProcedureCodeQual” char(2) default NULL.
16 “SubmittedProcedureCode” varchar(30) default NULL,
17 “SubmittedProcedureModifier1” char(2) default NULL,
18 "SubmittedProcedureModifier2” chan(2) default NULL.
19 "SubmittedProcedureModifier3” char(2) default MULL.
20 “SubmittedProcedureModifierd” char(2) default NULL.

SARE S R

21 "SubmittedProcedureCodeDesc” varchar(80) default NULL.
22 “UnitsCharged” varchar5) default NULL.
23 DTP*

Save

|

=

Execute Script I

Io0=]|

. Help I

The "Claim Lines" tab
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[ create Tables
~ Database —
" Microsoft SOL Server | & MySQOL/Generic

Payment Claims I Claim Level Ad) I Claim Lines

CrProgramData HIPAASuite HIPAA Claim Payment MasterScripts PaidClaimLineAdj_MyS0L.sql

Claim Line Adj | Provider Level Adi |

| CREATE TABLE "edi_paidclaimlinead)” (
2 ID" bi |n|f2I:|‘ MOT NULL auto_increment,
3 *LinelD" bigint(20) NOT NULL.
4 *AdjustmentGroup” char(2) default NULL
5 “AdjustmentReason” char(3) default MULL.
& "AdjustmentAmount” char(10) default MULL.
Adjustmenlﬂt'_f char(2) default NULL.,
UNIQUE KEY "ID" ("ID")
) ENGINE=InnoDB DEFAULT CHARSET=latin1;

Save

El

=

Execute Script I

. Help I

The "Claim Line Adj" tab
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[ Create Tables
~ Database
" Microsoft SCL Server

+ MySQL/Generic

Payment | Claimz Claim

Level Ad) Claim Lines Claim Line Ad)

CiProgramData'HIPAASuite' HIPAA Claim Payment Master'Scripts'ProviderLevelAdi_MySaL.sql

Provider Level Adj |

]

]
5]

CREATE TABLE "edi_providerleveladjustments” |

1D bigint{20) MOT NULL auto_incremeant,

“‘Payment/D” bigint(20) NOT NULL.

"ProviderlD” varchar(50) default NULL,
‘FiscalPenodDate” vur::hnnj'IZ] default MULL,
"AdjustmentReason” char(3) default NULL,
“Adjustmentidentifier” varchar(20) default MULL.

'Adjustment.ﬁ.muunt decimal(15.2)

UNIQUE KEY "ID" ("1D")

default NULL.,

10 ) ENGINE=InnoDB DEFAULT CHARSET=ulfs:

Save

El

=

Execute Script I

. Help I

The "Provider

Level Adj" tab

5.4 Viewing the Database Schema

To access the database schema, select the Data Export » 835 Database Schema in main

menu.

s HIPAA Claim Payment Master - 64bit

- Dutput Mo
% Printer

 Screen

DataExport | (Code Sets  Image

Setup EDIExchange  Help

835 Connection and Data Fields
835 Payments and Pald Claimes
B35 Table Creation

1@ O

|: 835 Database Schema

Creabe 535 EDI Files
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The "835 Database Schema" menu

You will see the following window.

[# Database Schema for Electronic Remittance Advice (835)

edi_providerleveladjustments

=lolx|

~ ¥ I
| edi_clai mpayment PaymentiD
9D ProviderlD [ —— - "]
TradingPartnerlD FiscalPeriodDate *d‘_-da”'“'e"'*"’d.l“ﬂmm“
ERsmny AdjustmentReason ¥ :
Filedate Adjustmentldentifier ClaimiD
TransactionHandlingCode Ao AGUpenTE T
P AdjustmentReason
DebitCredit — : Adjustmentamount edi_paidclaimlinead)
PaymentMethod e AdjustmentQty Yo
SendingBankMo ¥ = LinelD
SenderAccountNo PaymentiD P y AdjustmentGroup
PayerlD ProvidedD | edi_paidclaimlines | AdjustmentReason
PayerDivision FacilityType YD AdjustmentAmount
RecelvingBankNo FiscalPeriodDate ClaimlD AdjustmentQty
Receiverdccauntio :“im(oum ProcedureCode
Effectivedate otalCharges RevenueCode
CheckNumber Cami AdjProcedureCode
Productiondate CHNRSaT ChargedAmount
PayerMame QaimAmount Paiddmount
PlaniD ClaimPaid UnitsPaid
Payeraddressl PatientResponsiblity UnitsCharged
PayerAddress2 InsuranceType ServiceDate
PayerCity FapersClalmily ProviderControlNe
Payerstate FacilityTypeCode AuthNa
PayerZip ::ﬁ AttachmentCade
PayerDNumber LocationNumber
SubmitterID ERiorA U PriarAuthHo
HIN RepricedClaimhum AllowedAmaunt
NAIC ::e:::ll :;curd"um Tax
Ui
:frfl:-'::::?:.:f ReceivedDate - RemarkCodes

The "Database Schema to Electronic Remittance Advice (835)" window

This window shows how the tables are inter related.

5.5 Selecting Fields to Export
Once you have created your tables and tested connection and table names, you can select
which fields to export. Follow the instructions below.

1. Select Data Export » 835 Connection and Data Fields in the main menu.

w HIPAR Claim Payment Master - B4bit

File w\mcmm Image Setup EDIExchange  Help
: [ @ Conection andDataFiekds | @ :
= > 635 Payments and Paid Claims — @

—Quput Ml 535 Table Creation

& Briter 35 Database Schema

" Scieen Create 535 EDI Files

The "835 Connection and Data Fields" menu

2. You will be confronted with the following screen where you can set up the database
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connection and enter the names of the database tables.

[# Database and Field Setup =10 =
i~ HIPAA Provider Printer Extract Capabilities — | [ Fields to be d
The HIFAS Provider Printer natively raats a Pay t Claims Claim Lines
payment advice record &z a single Object. The = [JFie Level Data - [ PaymentlD [Key of Payment table] « O ClainlD [Key of Claim T able] |
HIPA4 Provider Printer extracts the complete [ TradingPartned D = [ Statistics [TS3) O PrecedureCode
Payment data from an EDI file into its proprietary [ EDIFileName [ ProvidedD: O RevenueCode
data object It can translate and exportthis data O Fiebate O FaciityType O submittedProcedureCode
into any ODBC compliant database. such as &[] FnanciaData [BPR Segment] [ FiscalPeiiodDate D ChargedAmount
Microsoft SQL Server. IBM 45400, Oracle and o T DO TransactionHandingCode [ ClarCourt D Paidamount
an, The default fields that come with the product o N " [ Positiorins [ UnitsPaid
can be extended. Customizations are pozsible 2y ¥
Ask Vendor for details [ DebitCiedt [ ToeCharges [ UnitsCharged
- O Paymenti sthad =[O Clzim Data O ServiceDate
~C ion Properti [ SendingBankho [ ClsimiD [ PrevidesControlo
O Sendebecounttlo O ClarPasitirinFile O Authie
O PayerD il [ ClamStatus [ attachmentCode
[ FaverDivision O Clarsmount O LoestionN urmber
Database Server Name [ ReceivingBarkNo O ClarPsid O Priocbuitiilo |
[ Receivertccounito [ PatientRespansibiity [0 HealthcarePalicylD
[ EtfectiveD ate O inswranceType O Aowedbmount =
Database | ] CheckNumber or EFT Nurber [ PapersClaimiD M. 5
Usemame | [ ProductionD ate [ FacibtyTypeCode Select All | Select None |
=) [ Payer Information CaM Provider Level Adjustments
Password | [ Payerame o [ PaymentiD (ey of Pagment Table)
[ FlaniD ce Payer ID [ GroupciPolicyMurn ProvideslD
Payment Table  |edi_caimpayment [ Payertddress [ Membed dentium g FiscalPerodDat
) — [ Payerbdduess? O Priottuthibium [ FiscaPeiodate
Claim Table W A O AdiustreniReason
O PayerCity L PreDeterminatiorum O Adjustmerdidentéier
Line Table edi_paidelaimlines [ PayerState [ RepicedClaimhumn [ Adiustrentamount
- PP — O PayeiZo O Awhesizatiorlum =
Claim Adjustments|e di_claimleveladiustments E Spm?;;mber Select Al | Select None | Select All | Setect None |
Line Adjustments |edi_paidclaimlineadi CIHN Claim Level Adjustments Line Level Adjustments
Provider Level Adj. |edi_providereveladjustments O naic [m] ClamiD [Key of Claim Table] [m] LinelD) (Key of Claim Line Table)
[ PayerCantact O AdustmentGioup O AdjustineniGroup
o1l call o eate the tables through a separate O PayerT elefon O AdpstmentReason O AdjustmentReason
Screen [ PayerFax = [ Adpstmentimaunt O Adstmentémount
Save Connection Information I Al pRiLSSS | _>|—I O AdmstmentQy O AdiustmentQty
TestCarnection_| I~ Connection not checked Select Al SelectMore | Seectél | sewctbore | Selectl | SelectNane
Test Canfiguration | Save Field Configuration |
Cancel | Help |

The "Database and Field Export” window

3. Choose fields to be exported by selecting checkboxes in front of the fields in the

following tables:

Tip: We recommend to select all fields. This makes it possible to reassemble all the information in the
EDI file and create the image of the claim payment.

e Payment

¢ Claims

Claim Lines

Claim Level Adjustments

Provider Level Adjustments

e Line Level Adjustments

Tip: Sometimes it might be necessary to rename a field or fields. Some legacy database want upper
case only or lower case only field names. The HIPAA Claim Payment Master allows you to rename any
field in any table. Click twice (not double-click) on a field and you are in "Edit" mode.
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The field selection list in "Edit" Mode

4. Once you have made your selection or selected all you have to test your setup, click on
the "Test Configuration” button. The program will go through each table and check if the

selected field exists.

B =10l x|
— Felds to be exported
Payment Claims Claim Lines
=[] File Level Data [] PaymentID (Key of Payment tabls) & | [ ClaimID ey of Clairn Tabie) =
[ TradingPartnerD =[] Statistics (T53) ProcadureCode
[l EDIFieName [ ProviderlD [F RevenueCode
FileDate [ Faciity Type [ Submitted ProcedureCode
= [ FinancialDiata (BFR Sagment) [ FiscalPeriodDate [F ChargedAmaunt
[ TransactionHandingCode [ ClaimCount [ Paid Amount
B PaymentAmount Posttionin Summary UnitsPaid
[#] DebitCrecit [ TotalCharges [#] UnitsCharged
Payment Method - [ Claim Data [ ServiceDate
[ SendngBarkiio A ClaimiD | | [# ProviderCortrolNa
] SenderAccount Mo [ ClaimPostioninFie B Authie
] PayerlD Claim Status AtachmentCode
[#] PayerDivision [ ClaimAmount [ LocationMumber
Recsiving Bank Mo F CzimPaid [ PriorAuthio |
] ReceiverAccountio [ Patiert Responsibility [l Healthcare Policy|D
[ Effective Date [ Insurance Type [ Alewed Amaount =
7] CheckMumber or EFT Number PayersClaim|D AT
[ ProductionDate [ Facizy TypeCode | Selact Al | Salect None
=M Eﬁmm % E& Provider Level Adjustments
[ Flan|D or Payer 1D B GrouporPelieyMum g ;walg {Hey of Payment Table)
B Payeriddress MenberideriNium ] FiscalPerodDate
(] Payertddress2 [ PriesAuthNum B AdustmentReason
PayerCity [ PreDeteminationhium e ertfiar
(7] PayerState [E) RepricedCiamMum B Adust
A PayerZip [ AuthorizationNum =
%mﬂmn | SelectAl | Selcthone ||  SelectAl | SelectNone
HIM Claim Level Adjustments Line Level Adjustments
FIHAC [¥] ClaimID (Key of Claim Tabie) [ Lin=ID (Key of Claim Line Table)
PayerContact [ AdpstmentGroup [ AdustmentGroup
] PayerTalafon [+ Adiustment Reason [ Adiustment Reason
[l PayerFax = [ Adiustment Amount [ Adustment Amount
«| = |_|‘I‘_I [ AdustmentGty [ AdstmentGty
| Selecta | SelectMone ||  SelectAl | SelectNone ||  SelectAl |  Select None
C Test Configuration D Save Field Configuration |

The "Test Configuration” button

5. You should receive a message like this. Click "OK."
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x|

Setup chedks okay!
()

The success message

6. Only after the configuration checks out are you allowed to save it. Click the "Save Field

Configuration” button.

B =10 x|
~ Felds to be exported
Payment Claims Claim Lines
= [ File Level Data | [ PaymentID (ey of Fayment table) & | [ ClaimiD (Key of Claim Tabie) -
[ TradingParinerlD = [ Statistics (T53) [ ProcedureCode
[# EDIFieMame [ ProvidedD [# RevenueCode
[ FleDate Facilty Type [ SubmittedProcadureCode
- ] FinancialData (BFR Segment) B FiscalPerodDate ] ChargedAmount
[ TransactionHandingCode B QaimCount [ PaidAmount
[ PaymentAmount [#] Postionin Summary UnitsPaid
[A DebitCredt [ TotalCharges [ UnitsCharged
A Payment Methed = [#] Claim Data [ ServiceDate
[F] SendingBarikho [ ClaimiD | | [ ProviderContraibia
B SenderhcccuntMNo [ QaimPostioninFie [ Authto
PayerlD = B QlaimStatus [ AttachmentCode
[ PayerDivision ] ClaimAmownt ] LocationMumber
[ ReceivingBankNo B ClaimPaid [ PriestuthNe |
] ReceiverAccount o ] Patient Responsibiity (] Healthcare Policy|D
[ Efective Date [] Insurance Type ] Mlowed Amount :I
[F] Check Number or EFT Number [ PayersClaimiD Bl Lo
[ FroductionDate [ Facility TypeCode | Selact Al | Select None |
= B Payer ifomation MIA Provider Level Adjustments
] Payertiame £ MoA [ [ PaymentiD (Key of Payment Table)
EA PlaniD or Payer ID B GrouparPeleyMum 2] ProvideriD
[ Payerfddress1 ] Memberident Num [E] FiscalPedodDate
[ Payeriddess2 ] PriorAuthMNum E] AdustmentR
[ PayerCity Pre DeterminationMum !
\ [ Adiustment|dentfier
[ Payerstate ] RepricedClamhum ] AdustmentAmourt
[ FayerZio B Authorzationhum |
Emnmmn | selectAl | o SelectNone ||  Seecm | SelectNone |
B =N Claim Level Adjustments Line Level Adjustments
[ rsic [ ClaimID (Key of Claim Tabie) 7] Lirwz|D {Key of Claim Line Table)
B PayerContact [ AdustmentGroup B AdustmentGroup
[ PayerTelsfon [ Adiustment Reason [ Adiustment Reason
[ PayerFax [#] Adustment Amount [ Adustment Amournt
N |_,J Elﬂd-mmw B AdwstmentGty
| Seloct M | Select None
Test Configuration | | Sm Field Configuration I I
e

The "Save Field Configuration” button

Troubleshooting Data Fields

Once you have made your selection or selected all you have to test your setup. Click on
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the "Test Configuration” button.

If the program finds errors, the ODBC Error screen will come up and tell you exactly
which fields caused errors.

=10/
------- Table edi_paidclaims ======= _;I

ERROR [42822] [MySQLJJODBC 5.1 Driver)imysqld-5.5.21]Unknown column "MIA” in ‘field list’

Cancel | Help - What is going on | Cuﬂmmm&wh

The ODBC error window

You can study the errors and the message usually is precise enough to understand what is
wrong. In the above case an access database is missing the fields in error. When you click
the "Uncheck Fields in Error” button, then all those fields will be unchecked and excluded
from the data export.

© 2012



76 The HIPAAsuite Claim Payment Master
[ =10l
~ Felds to be exporied

Payment Claims Claim Lines
- [ Fie Level Data - [l PaymentID (Key of Payment table] | Bl CaimID (Key of Claim Tabie) -
[#] TradingParinerD =[] Statistics (TS3) ] ProcadureCode
[ EDIFieName [ FrovideriD (] RevenueCode
[A FieDate Faciity Type Submitied ProcedureCode
= [F] FinancialDiata (BFR Sagmant) [ FiscalPedodDate [l ChargedAmount
[A TransactionHandingCade [ ClamCount B PadAmount
[ PaymentAmaount [ PostioninSummary UnitsPaid
[ DebiCredt [ TetaiCharges [ UnitsCharged
[ Payment Method = [ Clzim Data ServiceDate
[# SendingBankNo [ ClaimiD | | (] ProviderControlNo
[ SenderAecountMa B QaimPastioninFie [ Authte
[ BayerD B B QzimStatus B AttachmentCode
[ PayerDivision [ CaimAmourt ] LocationNumber
[ RecenvingBankho B CaimPaid PriceAuthho | |
E ReceiverAccount Mo E Patiert Responsibility E Healthcane PolicylD
[ EfectiveDate [ Insurance Type ] Allowed Amount LI
[ Check Number or EFT Number B PayersClaimiD EAT.
[ ProductionDate 7 Facity TypeCode | SelectAl | SelectNone |
=1 [ Payer information u
[ Payectiame S 0s Provéldir l.auT[! ﬂ:{a:neme]
[ FlzniD or Payer ID [ GrouporPebeyMum Emn ayment
[#] Payeriddress1 [l Memberidentium [ FiscalPedodDate
[ Payeriddmss2 [ PriorfuthNum B Adustment
[ PayerCty Fre Dietermination Num MMMML
[ PayerState 71 RepricedClaimNum B Adus
A PayerZip [ Autherization Num = rentAmourt
%P‘Y‘“':'"ILS"’” | SekedtAl | SelectNone ||  SeledtAl |  SelectNone |
B Hm Claim Level Adjustments Line Level Adjustments
[ HALC [#] Claim|D (Key of Claim Table) [#] LineID {Hey of Claim Line Table)
[ PayerContact B AdiustmentGroup B AdiustmentGroup
[#] PayerTelefon el Adustment Reason 7] Adustment Reason
[ FayerFax = B Adustment Amount [ Adustment Amount
o === |L,J B Adustmentlty B Adustmentlty
| Select Al | selectMore || SelectAl | SelectNone || SeeatMl |  SelectNone |
Test Configuration Save Field Configuration I
1
Fields that caused problems are unchecked now and excluded from export
Now you can test the configuration again. You should get the success message:
B
Setup checks okay!
The success message
Only after the configuration checks out are you allowed to save it. Click on the "Save
Field Configuration” button.
5.6 Browsing Exported Data

The HIPAA Claim Payment Master can take the records in the database to which it
exports and reassembles the information so that it can be viewed just like the images
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from the EDI file.

Select the Data Export » 835 Payments and Paid Claims in the main menu.

s HIPAA Claim Payment Master - B4bit

DataExport |/ Code Sets  Image  Setup  EDIExchange  Help

9@ ®

835 Table Creation
B35 Database Schema

Creabe 335 ED] Files
The "835 Payments and Paid Claims" menu

You will see the following screen. When you click on a payment on the left, the claims
associated with this payment get loaded on the right side.

8 Claim Payments in Database

The "835 Payments and Paid Claims" window

Double clicking on a claim will load this claim in a preview window.
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5.7

i
: Pnnt Close = 1f1 ==  Help
Explanation of Payment
PAYe" Great Benefit Plan PAYEE" DR MARCUS J WELBY
100 MAIN STREET 55 HIGH STREET
KANSAS CITY, MO 64108 SEATTLE, WA 93123
Pay Method Check Bank 1D
Account # Account #
Chik Iss JEFT Date 05/18/2002 Total Amt $175.00
PayerID: Check/EFT No 16588
Claim 1
| Patient Name: JOHN DOE Member ID Number 11122333301 |
I Frovider Mame.  JOHN WELBY Federal 1D 987121234 |
Claim Identifier 985019 Status: Processed as Primary DRG Code:
Total Charge Amt: $305.00 Facility Office Control #: 229800001
Payment Amt. $175.00 Frequency DRG Weight
Patient Resp Amt: $15.00 Filling Provider Organization Discharge Fraction:
I e e J\WWW

Claim details assembled from the database

If you have previously selected all fields to be exported, then you will have all the
information from the source EDI file. But for the largest part you can completely
reassemble the payment details as they came in on the EDI file.

De-ldentifying Data

"De-identifying Utility" can be used to "de-identify” X12 HIPAA transactions. You can
replace Private Medical Information (PMI) with random numbers and names. This should
facilitate the testing of the HIPAA transactions without compromising individuals' privacy.
The software is free for all users. Read more on http://www.claredi.com.

It is your responsibility to make sure the configuration file meets your de-identification
requirements.

1.Go to Help » De-identifying Utility in the main menu.
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s HIPAR Claim Payment Master - 64bit

File View DataExport CodeSets Image Setup  EDI Exchange _Hﬂb;,

@ > A @ | (7w
~ Dutput Mode - - About
 Prinker Check For Updates
£ Screen Project Hisbory
" Image Fie _ Repart an Issue Chri+l
| _ Locoogey |
™ Data Import A& a Features and Licenses _

The "De-identify Utility” menu item

2. Look through the information on the Introduction screen. Optionally check the "Do not
show this message again” option. Click OK.

De-Tdentify utility _EI

This free software removes protected health information (PHI)
from ®12 HIFAA transactions. This facilitates the testing of the
HIFAA transactions without compromising individuals' privacy.

This application is courtesy of waw. Claredi.com
|ssue Tracking
" Do not show this message again I

The introductory window

4

3. Familiarize yourself with the information. Click OK.

¥12 De-Identification Litility EI

Clared iz making availabls & program o “de-identify’’ 312 HIPAA -
tranzachons. This should facibtate the testing of the HIPAA tranzachons
without compromising individuals' privacy. The software i be fres for 2l
mgnﬂmmmhmwdufmUmwmwmmh
it wownzell.

Please feel free to use this program with wour HIPAA transactions, all we ae
athing is that wou lat us know of your results, good or bad, and you
suggestions for improvement. JAnd if you come up with “interesting™
configuration files, we want to know sbout those too, The sample
EﬂfmﬂhﬂumnmmmlthlPﬁmm
uides.

It iz pour responsibilly lo make sue the configuiation fle meets pou )
de-identfication

requarements. To keep our sltomey's blood pressure in
check we must remind you that this is being distribuled with no wananty, = |

o |

The information window
4. Specify the following:

¢ File to de-identify - Click on "Dots" button to browse for a resource HIPAA file on
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your local PC.

e Save de-identified file to - Click on "Dots" button to select a destination file on your
local PC.

B X12 De-Identification Utility o =]

Fike to de-identify | Jil

Save de-identiied file to

claredi o | _ca_|

The "X12 De-Identification Utility" window

5. Click on the "De-identify now" button to process the file. As the result, you will receive
a sucess message like this, click OK.

De-Identification Result x|

\i.) The File was successfully de-identified
()

The "De-Identification Result” popup

You may be informed about error/notification messages generated by the utility. Click
"Yes" to access them.

De-TIdentification Information |

i ] One or more messages were generabed while de-identifyving,
‘Would yiou ke bo view the messages?

s D m |

The "De-Identification Information” popup

Changing Configuration

To change the De-identifying Utility configuration, click on the "Configuration” button.

Ex %12 De-Identification Utility o [s] |
Fila to de-identily | [l
Save deidentiied fieto | [

'
claredi G ) w |

The "Setting” button on the utility window
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Click on "Edit" to open a configuration file.
serings x|
cmrwum|

Configuration Fie:
[C-\Program Files\HIPAAsule\HIPAA Claim Payment Mast =] [__]

(=

ok | cancel |  Hen |

The "Edit" button

This configuration file has a lot more than what you need, and in most cases all you have
to do is remove the "#" at the beginning of a line in order to put that line into effect. At
first time, only patient and subscriber information is de-identified, and provider
information is left intact. That is easily changed by removing the "#" at the beginning of
some of the lines.
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P x12deid.cfg - Notepad =10] x|

File Edt Format Yiew Help

[# sampTe configuration file for xd2deid (version 1.3 471703 - KZ) i
contains B37P/I/D, B35, 270, 271, 276, 277, 278, 834, 820

The 1ines have two parts separated by one or more spaces (or tabs)

The first part is the “tag” for the segment to replace or de-identify

The second part is the replacement data.
In the replacement data, any “emﬁty“ data element will indicate that the
data s not to be replaced and the original data must remain intact.
otherwise, if there is replacement data in that element, the replacement
data will be used instead of the original, and if the replacement data is
a single tilde "~" then the element will be blanked out. 8lanking out
with Tildes should rarely be used, as it distorts the original data.

If the original did not have data in_an element, the output will
not have data in that element even if the replacement data exists.

If the replacement data starts with "?" then the replacement only takes
place if there was no data for that element. IF there was any data in irt,
the replacement does not take place.

If the replacement data starts with "+" then the replacement takes

place every time, even if there was no data for that element.

The configuration file accepts only "%" as the element delimiter, and does
not use segment terminators. Composite data elements are replaced as a whole
at this time, and individual components of a composite are not replaceable

at this time. The BIN segment is not handled yet.

even though the configuration file only accepts the "*" as the delimiter, the
data itself may have any walid x12 delimiter.

This configuration file has a Tot more than what you need, and in most cases

all you have to do 95 remove the "#" at the beginning of a2 Tine in order to

put that line into effect. At this time, only patient and subscriber

information is de-identified, and provider in¥nrmatiun is left intact. That

is easily changed by removing the “#" at the beginning of some of the Tines -

e e e W e W R T R W e W o T T o T T e Tk R e T R e R R

1=
N

The configuration file

The lines have two parts separated by one or more spaces (or tabs):
e The first part is the "tag” for the segment to replace or de-identify.
e The second part is the replacement data.

In the replacement data, any "empty” data element will indicate that the data is not to
be replaced and the original data must remain intact. Otherwise, if there is replacement
data in that element, the replacement data will be used instead of the original, and if
the replacement data is a single tilde "~" then the element will be blanked out. Blanking
out with tildes should rarely be used, as it distorts the original data.

If the original did not have data in an element, the output will not have data in that
element even if the replacement data exists.

If the replacement data starts with "?" then the replacement only takes place if there was
no data for that element. If there was any data in it, the replacement does not take
place.

If the replacement data starts with "+" then the replacement takes place every time,
even if there was no data for that element.
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6.1

The configuration file accepts only "*" as the element delimiter, and does not use
segment terminators. Composite data elements are replaced as a whole at this time,
and individual components of a composite are not replaceable at this time. The BIN
segment is not handled yet. Even though the configuration file only accepts the "*" as the
delimiter, the data itself may have any valid X12 delimiter.

Claim Adjudication
Concepts

From the beginning of HIPAA and healthcare EDI it was envisioned that all transactions
between healthcare entities can be modeled in the EDI implementation guides.

The 837 formats for example are designed to accommodate every sector of healthcare
services. The 835 can in every detail explain the reimbursement process and the
adjustments taken from the charges a provider puts forward.

With the adjudication module of the HIPAA Claim Payment Master we are using the
capabilities of the HIPAA Claim Master to store EDI claims in a database and give the
ability to adjudicate and pay those claims. Critical to this model is the ability to manually
perform all the operations that the HIPAA model contains to adjudicate claims. Once
claims are adjudicated they can be bundled by payee, which is usually the billing provider
and paid including the creation of the payment CCD+ transaction and the remittance
advice in the 835 format.

At the same time a claim status is assigned to each claim or service line and the 277
claim status response can be given automatically with our HIPAA Claim Status Responder
and HIPAA RealTime Server.

The paid claim information can also be forwarded to other down stream payers with the
post adjudicated claim format X298, X299 and X300.

The goal is to have total claim management within HIPAAsuite appllications and perform
out of the box the most important transactions of a health indemnity organization.
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6.2

e [ s

Adjudication Prerequisites

Prerequisites

This chapter assumes the HIPAA Claim Master and HIPAA Claim Payment Master are both
installed and configured. Claims imported to the Claim tables (using the HIPAA Claim
Master or otherwise) will be adjudicated through the HIPAA Claim Payment Master.

Of note is that the EDI claims tables need the Claim Feedback fields added which are
commented out by default.
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B8 Create SOL Tables

Database Environment
® Microsoft SQL Server O Oracle ® Live Database
O MySQL/Generic C pB2 O Test Database

Claim Header Tables script:

[7Claim Feedback™/
--[ReceiverStatusCategory] [varchar](2) NULL.
—[ReceiverStatus] [varchar](3) NULL,
—[ReceiverActionCode] [varchar](2) NULL,
—[BillProvStatusCategory] [varchar](2) NULL.

—[BillProvStatus] [varchar](3) NULL.
—[BillProvActionCode] [varchar](2) NULL,
-[ClaimStatusCategory] [varchar](2) NULL.
-[ClaimStatus] [varchar](3) NULL,
—[ClaimActionCode] [varchar](2) NULL,
—[EffectiveDate] [date] NULL,
-[AdjudicationDate] [date] NULL,
-[PaidAmount] [numeric](18. 2) NULL,

-[PaidDate] [date] NULL,
—ICheckhnl fvarchari 161 NI

Compare Script with existing Table Save Execute Script

Claim Detail Table Script:

T Gy ST ZFa ST Ty = THS T T2, ] TYOTL
OtherPayer2AdjustmentReasonGroup5Plus] [varchar](77) NULL,
OtherPayer2AdjustmentReason5Plus] [varchar](155) NULL,
OtherPayer2AdjustmentAmount5Plus] [varchar](493) NULL,
OtherPayer2AdjustmentQuantitySPlus] [varchar](415) NULL.
[OtherPayer2PaidDate] [date] NULL,

[OtherPayer2AmountOwed] [money] NULL,

[*Claim Feedback™(

-[ClaimStatusCategory] [varchar](23) NULL,

-[ClaimStatus] [varchar](23) NULL,

—[EffectiveDate] [date] NULL,

-[PaidAmount] [numeric](18. 2) NULL,

CONSTRAINT [PK_edi_ClaimDetail] PRIMARY KEY CLUSTERED

MD1 ASC
Compare Script with existing Table Save Execute Script

Table Creation window in HIPAA Claim Master. The claim feedback fields are currently commented and are
ignored when executing the script.

To add these fields to an existing table easily,

e open the table Creation window in the HIPAA Claim Master and

e scroll to the bottom of the scripts. You can see the commented fields in green.
e Remove the dashes placed in front of each claim feedback field (--), click Save,
e then click Compare Script with existing Table, and

e run the resulting script for both the Claim table and the Claim Detail table.

The fields configuration must also include the Claim Feedback data fields. They are
grayed out and not selected by the Select All button.
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ection - O *
Fields to be exported
single Object. Header Detail
nd write those into a [ aPG_amount ~ [~ OtherPayer2Adjustmentamount1 -
SaL Server, Cracle, -] ApprovedRevenueCode .[] OtherPayer2 AdjustmentQuantity 1
1 ODBC connectivity. ApprovedProcedureCode OtherPayer2AdjustmentReasonGroup2
ir for details ApprovedUnitCode .[”] OtherPayer2AdjustmentReason2
- ApprovedUnits ----OtherPayerzﬁxdjustment.'!\muuntz
RejectReason OtherPayerZAdjustmentQuantity2
ComplianceCode OtherPayer2AdjustmentReasonGroup3
ction - . ExceptionCode OtherPayer2AdjustmentReason3
E—:I-- C Ackno ment OtherPayer2AdjustmentAmount3
= OtherPayer2AdjustmentQuantity3
OtherPayer2AdjustmentReazonGroupd
i OtherPayer2AdjustmentReasond
OtherPayer2Adjustmentamount4
:| OtherPayerZAdjustmentQuantity4
|:| OtherPayer2Ad roupSPius
Test Connection
:I Checked
:I You can create the
tables through a BD
separate screen . ; unt "
:| -[CJErrormessage v £ >
Select All Select None Select All Select Hone
[] show selected Fields only
Ml Test Configuration
Detail of field configuration screen in HIPAA Claim Master. The gray Claim Acknowledgment fields are
displayed.
6.3  Setting up Database Connection

The HIPAA Claim Payment master can adjudicate claims imported through the HIPAA
Claim Master. This chapter assumes you have configured the database connection for
HIPAA Claim Payment master, installed HIPAA Claim Master and configured Claim Master's
database connection, tables and fields. To set up the Adjudication tables, first open the
adjudication menu and select Adjudication Data Fields:
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nent Master - 32bit

base | Adjudication | CodeSets Image  Setup
=~ | Adjudication Data Fields |
FEDE]

Adjudication Table Creation
Default Settings

Adjudicate Claimn
Manage Claims for Adjudication
Pay Adjudicated Claims

Adjudication menu. Adjudication Data Fields option

87

EI

o

is highlighted.

The resulting window is the Adjudication Field Setup screen.

Adjudication Field Setup

L ion P

Adjustrment Header IclaimAdJustmentHeadar You can create the tables

Adjustrnent Detail IclalmAdJustmentDetall

Adjustrment Payment IclaimAdJustmentF’ayment

Payee ISturedF'ayea

Post.Adj.Claims |F'A_Claims

Post.Adj. Claitm Details [PA_ClaimDetail

Save Connection Test Connection | I

through a separate screen

—Fields to be d
Header |Delai| I Paymenl' Fayee' Fost.Adi.CIaimsl Post.Adj.Claim Delailsl
Adjustment Header

= [ Adiudication Header

[ ClaimMNumber

- [#] PravClaiml D

- [ BilProviD

- [#] BillProvM ame
Paymentt ethod

- [#] PaymentiD

- ] AdiudicationD ate:

PaymentD ate

Paymentémaount

ResponsibilityLevel
- [#] Payert ame

Claims Tables
’7J Claim Tables are successfully tested.

Test |

PayerlDCode
- [ Payer D
- [ Payertddress
- [ PaperCity

Cancel Help |

- [#] PayerState
PayerZIP

- [#] PaperRefTppe

- [l PayerRef

| Select Al ‘ Select Nong

Test Configuration I Save Field| Configuration |

The Claim Fields setup screen.

The database connection itself is taken from the Database connection setup screen that

is explained in the previous chapter. Click the Test Connection button to test the

database connection.

This will inform you if your database connection details are correct and whether a

database connection could be made:
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Error

Success establishing connection

Invalid object name 'claimAdjustmentHeader'.
Invalid object name 'claimAdjustmentDetail'.

oK

Message indicating a successful connections with no tables.

Though the database connection was successful, the tables that store the adjudication
and payment information need to be created. Do do that click on the blue label that says
"You can create the tables through a separate screen”.

— Connection Properties

Adjustment Header Iclaim.ﬁ.djustmentHeader

Adjustrnent Detail |claimadjustmentDetail

Adjustment Payment Iclaim.ﬁ.djustmentpa}-’ment

Fayee IStu:uredF'ayee

Post Adj.Claims |P4_Claims

Post Adj.Claim Details [F4_claimDetail

Save Conneclion

You can create the tahles
through a separate screen

Test Connection v

Adjudication Field Setup screen. Click the highlighted text to create the tables.

A new screen comes up that let's us create the tables.

The scripts to create the adjudication tables are presented in the resulting screen. Select
the appropriate database option and click Execute Script to create the table. Do this for

all six tabs.
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fE] Create Adjudication Tables =] B3
Database

# Microsoft SOL Server © MyS0L/Generc ¢ Oracle © DEZ2

Clairm Adjustment Header | Claim Adjustrment Detail | Claim FPayrments | Favee I Post-ad).Claimz | Post-td). Claim Details

Claim Adjustment Header Tahle script:

1 CREATE TABLE [dbo].[ClaimAdjustmentHeader]( a
[1D] bigint IDENTITY (1. 1) NOT MULL.
|ClaimMumber] [varchar](50) NULL,
[ProvClaimlD] [varchar](50) NULL,
[BillProvID] [varchar](80) NULL,
[BillProvMame] [varchar](150) NULL,
|PaymentMethod] [varchar](3) NULL,
[PaymentlD] [varchar](50) NULL,
[AdjudicationDate] [date] NULL,
[PaymentDate] [date] NULL.

1 [PaymentAmount] [money] NULL. |
12 |ReszponsibilityLevel] [varchar](5) NULL,
13 [PayerMName] [varchar](150) MULL.

14 [PayerlDCode] [varchar](30) NULL,

15 [PayerlD] [varchar](50) MULL.

16 |PayerAddress| [varchar](150) NULL,
17 [PayerCity] [varchar](30) NULL,

18 |PayerState] [varchar](20) NULL,

19 [PayerZIP] [varchar](20) NULL,

20 [PayerRefType] [varchar](20) NULL,

21 [PayerRef] [varchar](50) NULL,

= D 00 =] N N e L B

—
=

22 |[AdjustmentReasonGroupT] [varchar](2) NULL, =
3 TAAdinetrmnntDascan 11 hrarchard 720 KILIL
Compare Script with existing Tahle | Table already exists Save | Execute Script |

dee |

Table Creation screen.

You should receive a similar success message as is shown below for each of the tables
created.

Success >

Table 'ClaimAdjustmentHeader' successfully created

0K

Table creation success message.

After the tables are created, we return to the Field Setup screen. Again we click on Test
Connection’
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— Connection Properties

Adjustment Header Iclaim.ﬁ.djustmentHeader You can create the tables

through a separate screen

Adjustrnent Detail |claimadiustmentDetail

Adjustment Payment Iclaim.ﬁ.djustmentpayment

Fayee IStu:uredF'ayee

Post Adj.Claims [Pa_Claims

Post. Adj.Clairm Details [F4_ClaimDetail

Save Connechion Test Connection | W

Adjudication Field Setup screen. Test connection button is highlighted.
The connection to the database and the adjustment tables will now be checked.

SuUCCess

Success establishing connection
Adjustment Header table verified
Adjustment Detall table verified

Adjustment Payment table verified

FPayes table verfied

FPost Adjudicated Claims table verified

FPost Adjudicated Claim Details table verified

h 4

0K

Successful database connectivity test.
Now we see a check mark next to the Test Connection’' button.

Now we need to test if the fields in the HIPAA Claim Master have been created that are
mentioned in the previous articlels4).

Claims Tables

/ Claim Tablez are succeszfully tested. Test |

Testing the presence of feed back fields in the EDI Claim tables.

If you do not get a positive message in this test, please go to HIPAA Claim Master and set
those fields up.

Now comes the third and final part of the database setup. We need to select the fields
that we want to use and check our selection. The easiest way is to click the Select All
buttons beneath the fields lists in each of the six tabs.
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— Fields to be exported

Header | Detail I Paymentl F‘a_veel Post Adj.Claimz | Post Adj.Claim Detailsl
Adjustment Header

= [¥] Adjudication Header -
- [#] ClaimMumber

- [#] PrawClairml D

- [#] BillProwlD

- [#] BillProwM ame

- [#] Payrnenttd ethod

- [#] PaymentiD

- o] AdiudicationD ate

- [#] PaymentD ate _
- [#] Paymentamaount

- [#] FesponsibilityLesvel

- [#] Payer ame:

- [#] Payer D Code

- [#] Payer D

- [#] Payerdddress

- [#] PayerCity

- [#] PayerState

- [#] PayerZIF

- [#] PayerRefType

- [l PaverRef 4

| Select All | Select Mone

Test Configuration | save Field Configuration |

Detail of Adjustment Field Setup screen. Select all fields buttons highlighted.

Click Test Configuration.

PayerRef Type Procedure Description
- [] PayerRef -] BundledLineNumber
i [] Adjustment ReazonGroup 1 - [/] Adjustment ReasonGroup 1

[+] Adjustment Reason 1 Adjustment Reason1
i Jr] Adiustment Amount 1 W i Jo] Adiustment Amount 1 w7
Select Al Select Mone Select Al Select Mone

Test Configuration

Cancel Help

Detail of Adjustment Field Setup screen. Test configuration button is highlighted.

This will check for the existence of all selected fields in the adjustment tables.

91
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Setup oy

\/ Fields Setup checks okay!

OK

Field setup success.

Finally, save the fields by clicking Save Field Configuration.

Iil PayerRef Type |g| Procedure Description
- [7] PayerRef -] BundledLineNumber
i [] Adjustment ReasonGroup 1 -] Adjustment ReasonGroup 1

é""ﬁdeStmEFﬂHEEISDH'I Adjustment Reason
i [o] Adiustment Amourt 1 hd i [] Adiustment Amourt 1 v
Select Al Select Mone Select Al Select Mone
Test Configuration Save Field Configuration
Cancel Help

Detail of Adjustment Field Setup screen. Save field configuration button is highlighted.

The HIPAA Claim Payment Master now has a record of which fields are currently used in
the database. This is especially helpful after an update that requires changes to the
database.

Troubleshooting
Below are errors you might find while configuring your adjustment table fields.

Testing the Database Connection

While testing the connection to database, if a connection cannot be established, refer to
the Setting up Database Connectionlss section in the Using the Database chapter to
check the database connection as these fields may be in error.
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Error X

A network-related or instance-specific error cccurred while establishing
e a connection to 5CL Server. The server was not found or was not
accessible, Verify that the instance name is correct and that SCL Server
is configured to allow remote connections. (provider: S0L Metwork
Interfaces, error: 26 - Error Locating Server/Instance Specified)

Error >

Error has occurred while establishing connection

OK

Errors indicating failed attempt at connecting to a database.

Testing the Field Configuration

When testing the table fields configuration, if any fields are missing (or misnamed), the
following error will be displayed.
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a5l SOL Errors - O *
======= Table claimAdjustmentDetail =======
Invalid column name 'PaidDate’.
Invalid column name 'PaidAmount’.
[ Cancel | Help - What is going on Uncheck Fields in Emror

Error during field configuration test. Two fields are missing from the claim adjustment detail table.

This might happen after an update. The table creation screen can add the missing fields.
Click the Compare Script[...] button, check the resulting table adjustment script, then

click the Execute Script button.

© 2012



Claim Adjudication 95

85 LLhanges to your table

B8 Create Adjudication Table 1 Alter Table ClaimAdjustmentDetail
' 2 Add
I 3 [PaidDate] [date] NULL,

[PaidAmount] NULL
@ Microsoft SQL Server O MySQL/Ge [PaidAmount] [money]

Claim Adjustment Header Claim Adjustment De

ClaimAdjustmentDetail Table script:

1 CREATE TAEBLE [dbo] [ClaimAdjustmentD
[ID] [bigint] IDENTITY{1,1) NOT NULL
[ClaimiD] [inf] NOT NULL.
[LineNumber] [int] NOT MULL,
[LinelD] [varchar]{50) NULL
[AdjudicationDate] [date] NULL,
[ChargeAmount] [money] NULL,
[PaidDate] [date] NULL,

[PaidAmount] [money] NULL,
[PayerlD] [varchar]{30) NULL.

| T LT <R L) o

i e

=l

11 [RevenueCode] [varchar](50) MULL,

12 [ProcedurelDQual] [varchar](3) NULL,

13 [ProcedurelD] [varchar](50) MULL,

14 [Units] [char]{2) NULL,

15 [ProcedureQuantity] [int] MULL
[Modifier1] [char]{3) NULL,

—t ek
] T3

Modifier2] [char](3) NULL,
18 [Modifier3] [char](3) MULL,
19 (Modifierd] [char](3) MULL,

20 [ProcedureDescription] [varchar](80) I
21 [BundledLineMumber] [int] NULL,

22 [AdjustmentReasonGroup1] [varchar](
W ThAimtmammt D cmn 1] heseakaed O30 BRI

Compare Script with existing Table I

Help Execute Script

—e———— = — I

Adding missing fields to a table.

6.4 Default Adjudication Action Setup

The default adjudication behavior can be adjusted in the default settings options. A line
that has not been manually adjudicated will be assigned the the default Claim Status and/
or Adjustment Reason or paid in full. To open the default claim adjustment settings
screen, click the Default Settings option under the Adjudication menu.
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&

[T TR TS

ise | Adjudication | CodeSets  Image  Setup |

Adjudication Data Fields \J

Adjudication Table Creation
| Default Settings |

Adjudicate Claim
Manage Claims for Adjudication
Pay Adjudicated Claims

Adjudication menu. Default settings option is highlighted.

The default adjustment settings will be applied to any unadjusted claim line. This allows
for quick adjustments. The default setup will mark any claim line that has not been
manually adjudicated for full payment. To change this behavior, check User Default
Values to Suspend Payment and select adjustment and claim status codes to adjust any
claim line that was not manually adjudicated.

o Adjustment Settings — O X

Company: |1 - HIPAASUITE v|
Default Claim Status Values after Adjudication
[] Use Default Values to Fill Claim Statuses
Claim Status Category Claim Status

Default Line Adjudication and Claim Status Values
® Pay Open Amount

O Use Default Values to Suspend Payment

Adjustment Reason Group Adjustment Reason
Claim Status Category Claim Status

Defaults screen.

Every company used has a different set of default adjudication values. To swap between
stored companies, use the company dropdown box.

ol Adjustrent Settings

Company. | 1-HIPAASUITE W

Default Claim Status Values after Adjudication
[] Use Default Values to Fill Claim Statuses

e el o o o
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Detail of the defaults screen. Company selection drop down box is highlighted.

The combo boxes may not have the option you need. If so, type in the claim status or
adjustment code and the box will fill in the rest.

Example: Entering "P1" into the Claim Status Category field...

® Use Default Values to Suspend Payment

Adjustment Reason Group
|CG - Contractual Obligations

Claim Status Category
Pl

Save

..will automatically fill in the corresponding definition for that code.

VEOUSE LEIdUIL Vdiues WD -DUspPenu rdyIineril

Adjustment R